About this Manual

Marks and Symbols

![Caution:]
Instructions that must be followed carefully to avoid bodily injury.

![Important:]
Instructions that must be observed to avoid damage to your equipment.

Note:
Instructions containing useful tips and restrictions on printer operation.

Related Information
Clicking this icon takes you to related information.

Artwork

Screenshots used in this manual are currently under development. They may differ from the release version.

Operating System References


- Microsoft® Windows® 10 operating system
- Microsoft® Windows® 8.1 operating system
- Microsoft® Windows® 8 operating system
- Microsoft® Windows® 7 operating system
- Microsoft® Windows Vista® operating system
- Microsoft® Windows Server® 2012 R2 operating system
- Microsoft® Windows Server® 2012 operating system
- Microsoft® Windows Server® 2008 R2 operating system
- Microsoft® Windows Server® 2008 operating system
### Contents

#### About this Manual
- Marks and Symbols ........................................... 2
- Artwork .......................................................... 2
- Operating System References ............................... 2

#### Epson Device Admin Features
- Main Features .................................................. 5
- Configuring the System ........................................ 6
- Languages ...................................................... 7

#### Setting Up
- System Requirements ......................................... 8
- Hardware ......................................................... 8
- Software ......................................................... 8
- Notes on operation ............................................ 9
- Installing and Configuring the Environment ............... 10
- Preparing to install ........................................... 10
- Installing for the first time and changing features ...... 10
- Starting up and closing Epson Device Admin ............ 13
- System settings ............................................... 13

#### Operation Screen
- Top Screen ...................................................... 14
- Summary of Each Main Screen .............................. 15
- Side bar task menus .......................................... 15
- Device management .......................................... 16
- Alert management ............................................ 17
- Report management .......................................... 18
- Configuration template management ..................... 19

#### Installation Settings
- Operation Settings ............................................ 21
  - Options screen .............................................. 22
  - Mail ............................................................ 23
  - Timing .......................................................... 24
  - Formats ....................................................... 25
  - Startup ....................................................... 26
  - Customize Ribbon ......................................... 27
  - Check for updates ......................................... 28
- Registering to the device list ............................... 29
- Discovering devices .......................................... 30
- Specifying individual devices .............................. 32

#### Device Management
- Device Settings ................................................. 43
- Settings Template .............................................. 43
- Creating a configuration template ......................... 43
- Applying configuration template ........................... 46
- Editing configuration templates ............................ 50
- Exporting and importing configuration templates ...... 51
- Setting or changing devices one at a time .............. 51
- Device properties screen .................................... 51
- Using an embeded web server to make device settings .. 53
- Setting an Administrator Password ....................... 54
- Setting individually ......................................... 54
- Managing passwords in batches ......................... 55
- Registering Different Address Books ..................... 60
- Editing individually ......................................... 60
- Making batch settings ....................................... 63
- Updating Device Firmware .................................. 67
- Updating firmware .......................................... 67

#### Daily Management
- Managing the Device List .................................... 69
- Collecting information regularly ......................... 69
- Displaying the device list settings ....................... 70
- Managing Alerts ............................................... 74
- Creating alerts ............................................... 74
- Adding groups monitored by alerts ....................... 76
- Setting the alert confirmation interval ................... 76
- Editing alerts .................................................. 77
- Switching the alert display ................................ 78
- Report Management .......................................... 79
- Creating reports .............................................. 79
- Acquiring data ............................................... 88
- Setting the data collection time and saving period .... 89
- Switching the report display ............................... 90
- Sending archived reports by email ....................... 92
- Saving and deleting archived reports .................... 94
Contents

**Maintenance**

- Printing a Status Sheet ........................................... 95
- Backing up and Restoring ........................................ 95
  - Items that can be backed up and restored .................. 95
  - System settings .............................................. 96
  - Device list .................................................. 98
  - Password settings ........................................... 100
  - Address books ................................................ 103
  - Configuration templates .................................... 107

**Troubleshooting**

- Troubleshooting .................................................. 109
  - Cannot discover devices ...................................... 109
  - Cannot change the network interface, or cannot use it on the network ................................................. 109
  - You do not know the IP address ............................. 110
  - The message "The network connection is invalid or not set. Check the network settings." is displayed when running Epson Device Admin ........................................ 110
  - Not Ready is displayed as the IP address on the device list ................................................................. 110
  - IP address changes on its own ................................ 111

**Appendix**

- Secondary Device Management Method ......................... 112
  - Assigning IP address ........................................... 112
  - Checking for overlapping items ................................ 112
  - Batch Settings .................................................. 113
    - Assigning information automatically ....................... 113
    - Assigning information from settings one at a time (Manually assigned) ........................................... 118
    - Creating a SYLK file to describe the settings .......... 123
    - Backing up device settings .................................. 129
    - Setting items for the SYLK file ............................. 131
  - Copyright and Trademarks ..................................... 135
  - Notices ....................................................... 135
Epson Device Admin Features

Main Features

Epson Device Admin is an application that allows you to install devices on the network, and then configure and manage the devices. The following outlines the main features.

- **Discovering devices**
  You can discovering Epson devices on the network, and then register them to a list. If Epson devices such as printers and scanners are connected to the same network segment as the administrator’s computer, you can find them even if they have not been assigned an IP address.

- **Setting devices**
  You can make a template containing setting items such as the network interface and the paper source, and apply it to other devices as shared settings. When it is connected to the network, you can assign an IP address on a device that has not been assigned an IP address.

- **Monitoring devices**
  You can regularly acquire the status and detailed information for devices on the network. You can also monitor devices from other companies that have been registered to the device list.

- **Managing alerts**
  You can monitor alerts about the status of devices and consumables. The system automatically sends notification emails to the administrator based on set conditions.

- **Managing reports**
  You can create regular reports as the system accumulates data on device usage and consumables. You can then save these created reports and send them by email.
Configuring the System

You can manage devices by setting up the following system.

- **Epson Device Admin system**
  This is a station where a computer for an IT administrator is installed so that devices can be managed. We recommend managing up to 2,000 devices from one computer.

- **Computers for an IT administrator**
  - **Device Admin Client**
    This software should be installed on the computer for the IT administrator.
  - **Device Admin Agent**
    This is installed along with this software, and then operates a service as part of a system. The regularly acquires information, prepares reports, and sends alert notifications. The Device Admin Agent Monitor monitors whether or not the Device Admin Agent operates correctly.
  - **EDA database**
    This is installed in this software and records all information.
Epson Device Admin Features

Languages

Epson Device Admin supports the following languages.

English, French, Italian, German, Spanish, Chinese (traditional), Russian, Portuguese (Brazilian), Chinese (Simplified), Portuguese (Portuguese), Dutch, Korean, Japanese
Setting Up

System Requirements

The following requirements are necessary to install this software.

Hardware

Minimum system requirements

- CPU: 2.0 GHz or faster x86/x64 processor
- Memory: 4 GB or more
- Hard disk: 500 MB or more free space (except Database usage)
- Display: 1024 x 768 or higher monitor resolution, High Color 32 bit

Recommended system requirements

- CPU: 2.8 GHz or faster x64 processor (server system)
- Memory: 8 GB or more
- Hard disk: 500 MB or more free space (except Database usage)
- Display: 1920 x 1080 or higher monitor resolution, High Color 32 bit

Software

Recommended Software

- Runtime: .NET Framework 4.0 or .NET Framework 4.5

  Note:
  .NET Framework 4.5 is installed as standard on Windows 8 and Windows Server 2012 or later.

- Internet Explorer 8 or later and Adobe Reader X or later
  These are necessary when displaying an archive report.
  Activate the Adobe PDF Reader add-on in Internet Explorer.


Setting Up

Ports to use

Epson Device Admin continuously listens to several ports, therefore those ports must be opened for specific features. The following are the ports used by Epson Device Admin.

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>161</td>
<td>Use this to acquire information on devices (SNMP).</td>
</tr>
<tr>
<td>3289</td>
<td>Use this to discover and configure devices on the network (ENPC).</td>
</tr>
<tr>
<td>427</td>
<td>Use this to discover devices on the network (SLP).</td>
</tr>
<tr>
<td>443</td>
<td>Use this to communicate by HTTPS, auto update, and update firmware.</td>
</tr>
<tr>
<td>25 (default)</td>
<td>Use this for the SMTP server that sends email. Change the port number depending on the server.</td>
</tr>
<tr>
<td>587 (default)</td>
<td>Use this to send email using extended SMTP for security.</td>
</tr>
<tr>
<td>110</td>
<td>Use this to send email using POP before SMTP.</td>
</tr>
<tr>
<td>10015 (default)</td>
<td>Use this to request interfaces that communicate between services and this software.</td>
</tr>
<tr>
<td>8080 (default)</td>
<td>Use this to configure the proxy server settings and access the Internet.</td>
</tr>
</tbody>
</table>

Windows services

This software registers the following as Windows services when setting up.

- Epson Device Admin Agent
- Epson Device Admin Agent Monitor

Virtual environment

This software will also operate under the following virtual environments. However, performance may decline depending on the environment.

- Hyper-V
- VMWare vSphere

Notes on operation

- Disable your computer’s sleep function, otherwise this software will not operate correctly.
- If you change the time zone setting while this software is operating, it will be applied after restarting.
- This software only supports IPv4.
- We recommend using servers for 24 hour operation.
Setting Up

Installing and Configuring the Environment

Preparing to install

You need to install .NET Framework 4.0 or .NET Framework 4.5 on the computer before you install this software. However, on computers running Windows 8 or Windows Server 2012 or later, you do not need to install it since .NET Framework 4.5 is installed as standard.

See the Microsoft Website for information on downloading .NET framework, installing, and explanations on usage.


Installing for the first time and changing features

| Important: |
| Login to the computer by using an administrator account. |

Initial installation

Follow the steps below to install this software.

1. Run Setup.exe.
   
   The Setup wizard starts.

   | Note: |
   | If the user account control screen is displayed, click Yes to allow installation. |

2. Click Next.
**Setting Up**

3. Check the licensing clauses, select **I accept the terms of the license agreement**, and then click **Next**.

4. Select the folder where you want to install this software and the database, and then click **Next**.

   **Note:**
   - Select **Browse** to change the destination where the software will be installed.
   - Select **Disc Capacity** to check the amount of free disc space.

5. Select the features that you want to add, and then click **Next**.

   You can also add the alert feature and the report feature. See the following for information on additional feature.

   - “Alert management” on page 17
   - “Report management” on page 18

6. Click **Install**.
Setting Up

Installation starts.

Click Finish when the installation complete screen is displayed.

Changing features and uninstalling

You can change the installed features and uninstall this software from the Windows Control Panel.

1. Open the Windows Control Panel.
2. Select Uninstall a program to display the program list.
3. Right-click Epson Device Admin.
4. Select one of the followings from the menu displayed.
   - To change a function: change
   - To uninstall the software: uninstall
Setting Up

Follow the on-screen instructions to uninstall or change this software.

Updating

The following information and files are maintained even if you install an updated program or change the features.

- Information on acquired devices
- Settings for the discovery parameters
- Database files (From Epson Device Admin 2.x or later)

Starting up and closing Epson Device Admin

- Start up
  
  Select Start menu - All Programs - EPSON - Epson Device Admin - Epson Device Admin.

- Close
  
  Click "x" at the top-right of the screen, or click at the top-left of the screen, and then select Close.

System settings

You can configure Email settings and ribbon menu settings for management by using the option menu in the ribbon menu on the device management screen.

See the following for more details.

☞ "Operation Settings" on page 21
The Epson Device Admin top screen is composed of the following panes.

The display changes depending on the item selected from the side bar task menu on the top screen.

<table>
<thead>
<tr>
<th>No.</th>
<th>Pane</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Title bar</td>
<td>Click the ? to open the Help to view explanations of each item in Epson Device Admin.</td>
</tr>
<tr>
<td>2</td>
<td>Side bar task menu</td>
<td>Changes the feature being used. The screen switches depending on the item selected.</td>
</tr>
<tr>
<td>3</td>
<td>Ribbon menu</td>
<td>Displays the menu for the feature selected on the side bar task menu.</td>
</tr>
<tr>
<td>4</td>
<td>Side bar content</td>
<td>Displays the hierarchy for the feature selected on the side bar task menu.</td>
</tr>
<tr>
<td>5</td>
<td>Display view</td>
<td>Displays information and setting content depending on the feature selected in the side bar task menu or the side bar content.</td>
</tr>
<tr>
<td>6</td>
<td>Detailed device information</td>
<td>Displays details on the device selected from the Device List when you select <strong>Device</strong> on the side bar task menu.</td>
</tr>
<tr>
<td>7</td>
<td>Status bar</td>
<td>Displays status information on the Device List when you select <strong>Device</strong> on the side bar task menu.</td>
</tr>
</tbody>
</table>
Summary of Each Main Screen

Side bar task menus

Select a menu to switch from one menu to another.

- **Device management screen**
  Allows you to manage devices on the network. You can discover and register devices, as well as update device information and so on.
  
  ➡️ “Device management” on page 16

- **Alert management screen**
  Allows you to manage alerts that are output from the device. The system can automatically inform you via email about devices with low supplies level, paper jam or device error.

  ➡️ “Alert management” on page 17

- **Report management screen**
  Allows you to manage reports that contain a variety of information about the devices. You can set how to output reports containing information such as the frequency the device is used and the number of times consumables are replaced.

  ➡️ “Report management” on page 18

- **Configuration template management screen**
  Allows you to manage settings for devices with templates. You can make settings for creating, applying, and backing up setting templates.

  ➡️ “Configuration template management” on page 19
Operation Screen

Device management

Displays the device management screen when selecting Device on the side bar task menu.

The device management screen is comprised of the following panes. See the following for available operations using the device management screen.

“Installation Settings” on page 21

<table>
<thead>
<tr>
<th>No.</th>
<th>Pane</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ribbon menu</td>
<td>There are three ribbons on the device management screen, and you can switch between them by clicking the tabs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>❑ <strong>Home</strong> tab</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Allows you to discover devices on the network, update information, change settings for the device, apply templates, and so on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>❑ <strong>View</strong> tab</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Allows you to set and change information displayed on the Device List.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>❑ <strong>Groups</strong> tab</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Allows you to make settings to manage devices in groups.</td>
</tr>
</tbody>
</table>
Alert management

Displays the alert management screen when selecting Alerts on the side bar task menu.
Operation Screen

The Alert management screen is comprised of the following panes. See the following for available operations using the Alert management screen.

☞ “Managing Alerts” on page 74

<table>
<thead>
<tr>
<th>No.</th>
<th>Pane</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ribbon menu</td>
<td>Creates alerts and manages information.</td>
</tr>
<tr>
<td>2</td>
<td>Tree view</td>
<td>Switches the display for alert template classifications.</td>
</tr>
<tr>
<td>3</td>
<td>Alert list</td>
<td>Displays the alert template list when anything except for Logs is selected in the tree view. Displays the logs list when Logs is selected in the tree view.</td>
</tr>
<tr>
<td>4</td>
<td>Alert group</td>
<td>Displays the groups subscribed to the alert templates selected in the alert template list. Displays log details when Logs is selected in the tree view.</td>
</tr>
</tbody>
</table>

Report management

Displays the report management screen when selecting Reports on the side bar task menu.

The Report management screen is comprised of the following panes. See the following for available operations using the Report management screen.

☞ “Report Management” on page 79
Operation Screen

<table>
<thead>
<tr>
<th>No.</th>
<th>Pane</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ribbon menu</td>
<td>Switches the ribbon menu according to the tree view selected on the report management screen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Database - Data Collection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Menus for data collection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- User Defined Report - Scheduled reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Menus for creating reports and formatting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- User Defined Report - Archived Reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Menus for report files.</td>
</tr>
<tr>
<td>2</td>
<td>Tree view</td>
<td>Displays data collection and report management trees. The ribbon menu and display view are switched depending on the selected item.</td>
</tr>
<tr>
<td>3</td>
<td>Display view</td>
<td>Displays the following depending on the item selected in the tree view.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Database - Data collection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Top area: List of data collection conditions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bottom area: List of devices</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- User Defined Report - Scheduled reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Top area: List of report schedules</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bottom area: Details about the selected schedule</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- User Defined Report - Archived Reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Top area: List of archive reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bottom area: Content of the selected archive report</td>
</tr>
</tbody>
</table>

Configuration template management
**Operation Screen**

Displays the configuration template management screen when you select **Configuration** on the side bar task menu.

The configuration template management screen is comprised of the following panes. See the following for available operations using the configuration template management screen.

☞ “Settings Template” on page 43

<table>
<thead>
<tr>
<th>No.</th>
<th>Pane</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ribbon menu</td>
<td>Manages configuration templates.</td>
</tr>
<tr>
<td>2</td>
<td>Tree view</td>
<td>Displays configuration templates in a folder tree formation. Switches display views depending on the selected item.</td>
</tr>
<tr>
<td>3</td>
<td>Display view</td>
<td>Displays the following depending on the item selected in tree view.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>☐ <strong>Configuration - Templates</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Top area: List of configuration templates</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bottom area: Content of the selected configuration template</td>
</tr>
<tr>
<td></td>
<td></td>
<td>☐ <strong>Configuration - Logs</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Top area: List of logs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bottom area: Content of the selected log</td>
</tr>
</tbody>
</table>
Installation Settings

Operation Settings

These settings are necessary to use each feature.

Device Registration

- Discovery Parameters: Discovery using an IP address
  - "Specifying an IP address" on page 31
- Discovery Parameters: Discovery using an IP address range
  - "Specifying an IP address range" on page 31
- Discovery Parameters: Discovery using a network address
  - "Specifying a network address" on page 31

System Settings

- Email notification settings
  - "Mail" on page 23
- Processing Time
  - "Schedule settings" on page 69
- Password Manager
  - "Managing passwords automatically" on page 55
- System settings
  - "Backing up system settings" on page 96

Detailed Settings

- "Firmware external site access
  - "Check for updates" on page 28
- Detailed Settings
  - "Formats" on page 25

Alert Notifications
Installation Settings

- Alert
  
  “Setting the alert confirmation interval” on page 76

Options screen

You can set discovery conditions as well as system settings on the Option screen.

1. Select Devices on the side bar task menu.

2. Select Home - Options on the ribbon menu.

3. Select the item you want to configure.

4. Set each item as necessary.

5. Click OK.
Mail

You can set the email server (mail sending server) used for the notification feature.

<table>
<thead>
<tr>
<th>Items</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name/IP address</td>
<td>Enter the host name or IP address for the SMTP server.</td>
</tr>
<tr>
<td></td>
<td>Enter the host name within 255 characters using A to Z, a to z, 0 to 9, hyphens (-), and underscores (_). The label should be within 63 characters.</td>
</tr>
<tr>
<td></td>
<td>Enter the IP address in IPv4 format using numbers and periods (.).</td>
</tr>
<tr>
<td>Port number</td>
<td>Enter the port number for the SMTP server from 1 to 65535.</td>
</tr>
<tr>
<td>Connect using STARTTLS encryption</td>
<td>Check the connection with the SMTP server.</td>
</tr>
<tr>
<td></td>
<td>Blue: Successfully connected to the server. Go to the next step.</td>
</tr>
<tr>
<td></td>
<td>Red: Failed to connect to the server.</td>
</tr>
<tr>
<td></td>
<td>If the software fails to connect to the server, check that all settings have been made correctly.</td>
</tr>
<tr>
<td>Server authentication settings</td>
<td>Select this if the server requires authentication to send emails.</td>
</tr>
<tr>
<td></td>
<td>Select the authentication method from SMTP Auth (SMTP authentication) or POP before SMTP.</td>
</tr>
<tr>
<td>Host name/IP address</td>
<td>Enter the host name or IP address for the authentication server when the authentication method is POP before SMTP.</td>
</tr>
<tr>
<td></td>
<td>The entered text is the same as the host name and IP address for the SMTP server.</td>
</tr>
<tr>
<td></td>
<td>When this is the same as the authentication for the SMTP server, select Same as the sending server.</td>
</tr>
<tr>
<td>Login ID</td>
<td>Enter the login ID for the SMTP server using up to 255 ASCII characters.</td>
</tr>
</tbody>
</table>
**Installation Settings**

<table>
<thead>
<tr>
<th>Items</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>Enter the password for the SMTP server using up to 255 ASCII characters.</td>
</tr>
<tr>
<td>Send Test Message</td>
<td>Check whether or not the test email can be sent to the receiver’s email address. This button is available once the host name/IP address, port number, and sender’s email address have been entered. For the test email, the title “Test Message” and body text “This email is a test.” are displayed in English regardless of the language setting.</td>
</tr>
</tbody>
</table>

**Timing**

Set timing of data collection and logs retention period.

---

![Timing settings](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Device Information</td>
<td>Sets the schedule to collect information about the devices using <strong>Auto-Update</strong> on the Device management screen.</td>
</tr>
<tr>
<td>Refresh interval</td>
<td>Collects device information at set intervals. You can set the interval time from 1 minute to 23 hours and 59 minutes in intervals of 1 minute.</td>
</tr>
<tr>
<td>Select the day of the week</td>
<td>Collects device information on the selected day and time. You can specify the time in intervals of 1 minute.</td>
</tr>
</tbody>
</table>
## Formats

Set the data delimiters, paper size, and units for the report.

### Item | Explanation
--- | ---
CSV data delimiter | Specifies data delimiters for CSV files when saving reports, archive reports, and so on. The default value is ",".

> “Report Management” on page 79

Paper Size Reference | Displays the paper size selected in this software. The default value is A4.

Unit | Displays the units selected in this software. The default value is Meter (m).
Installation Settings

Startup

Sets whether or not to collect device information when you start this software.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update device data at startup</td>
<td>Sets whether or not to collect all device information when you start this software.</td>
</tr>
<tr>
<td></td>
<td>“Updating Device Information” on page 33</td>
</tr>
<tr>
<td>Discovering and rebooting timeout (10-180)</td>
<td>Specifies the timeout time between the discovery and the reboot confirmation. You can specify 1 to 180 seconds in intervals of 1 second. The default is 60.</td>
</tr>
<tr>
<td></td>
<td>“Discovery condition settings” on page 30</td>
</tr>
</tbody>
</table>
Customize Ribbon

Set the ribbon menu display.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Batch Settings button</td>
<td>When this is selected, the <strong>Batch Settings</strong> button is displayed on the <strong>Home tab - Setting</strong> group on the ribbon menu for the Device Management screen. <a href="#">“Batch Settings” on page 113</a></td>
</tr>
<tr>
<td>Show Reset, Open, and Save buttons in the Device List</td>
<td>When this is selected, the <strong>Reset</strong>, <strong>Open</strong>, and <strong>Save</strong> buttons are displayed on the <strong>Home tab - Device List</strong> group on the ribbon menu for the Device Management screen. <a href="#">“Device list” on page 98</a></td>
</tr>
</tbody>
</table>
## Installation Settings

### Check for updates

Allows the software to access external sites to update this software or check and obtain firmware updates.

![Check for updates dialog](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check for software updates at startup</td>
<td>Checks for updates for the software at startup.</td>
</tr>
<tr>
<td>Check for firmware updates at startup</td>
<td>Allows the software to access external sites to check for firmware updates for devices.</td>
</tr>
</tbody>
</table>
| Proxy Server Settings                        | Select the proxy settings you want to use to access the Internet. Select from the following.  
  - No proxy  
  - Use system proxy settings  
  - Manual proxy configuration |
| Host name/IP address                         | Enter the host name or IP address for the proxy server when setting the proxy manually. The entered text is the same as the host name and IP address for the proxy server. Enter the host name within 255 characters using A to Z, a to z, 0 to 9, hyphens (-), and underscores (_). The label should be within 63 characters. Enter the IP address in IPv4 format using numbers and periods (.). |
| ![Success icon]                              | Check the connection with the proxy server.  
  Blue: Successfully connected to the server. Go to the next step.  
  Red: Failed to connect to the server.  
  If the software fails to connect to the server, check that all settings have been made correctly. |
| Port number                                  | Enter the port number for the proxy server from 1 to 65535. |
| Login ID                                     | Enter the login ID for the proxy server using up to 255 ASCII characters. |
| Password                                     | Enter the password for the proxy server using up to 255 ASCII characters. |
Registering to the device list

Registers devices managed on the network to the device list.

You can use the following registration methods. Use the method that best suits your daily operation needs.

- **Discover and register devices**
  
  Discover devices on the network and register them to the software. You can discover using conditions such as beyond segment and specify network range.
  
  ⚠️ "Discovering devices" on page 30

- **Specify individually and register**
  
  Specify the IP address and device ID and register it to the software. You can register specific devices or devices that were not found during a discovery.
  
  ⚠️ "Specifying individual devices" on page 32

- **Register from a device list file**
  
  Load a device information file containing the device list and register them to the software. This is useful when restoring or migrating a system.
  
  ⚠️ "Backing up and Restoring" on page 95
Discovering devices

When you start Epson Device Admin, it automatically discovers devices in the same segment and registers Epson devices to the device list.

**Note:**
Click the icon next to the progress bar to stop discovering.

Discovering by using the discovery button

This discovers using the conditions set on the device management screen.

1. Select Devices on the side bar task menu.
2. Click Options on the ribbon menu.
3. Set the appropriate conditions for the device you are discovering.
   
   See the following for details.

   “Discovery condition settings” on page 30

4. Click OK when you have finished setting the conditions.
5. Click Discovery.

The software starts discovering and registers located devices to the device list.

When you click Device List - Save on the ribbon menu, you can save the displayed device list to a file. However, group information is not saved.

“Backing up and Restoring” on page 95

**Note:**
When the software is connected to a network, it discovers for Epson devices even if no IP addresses have been assigned.

Discovery condition settings

Sets the conditions for discovering. You can discover by specifying IP addresses, an IP address range, and network addresses. You can discover when an IP address is assigned to a device. See the following for details.

**Note:**
- All enabled discovery conditions are performed in parallel.
- Epson devices in the same segment as Epson Device Admin can be discovered for regardless of the discovery conditions.
- Set the timeout for discovering from Options - Startup - Devices - Discovering and rebooting timeout (10-180)
**Installation Settings**

**Specifying an IP address**

Discovers for the specified IP address for the device using unicast.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable discovery with IP address</td>
<td>Select to enable this discovery condition.</td>
</tr>
<tr>
<td>Add</td>
<td>Displays the screen where you can add an IP address</td>
</tr>
<tr>
<td></td>
<td>Enter the IP address for the device you want to discover in IPv4 format.</td>
</tr>
<tr>
<td></td>
<td>You can register up to 100 IP addresses.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected IP address from the IP address list.</td>
</tr>
<tr>
<td>Up, Down</td>
<td>Moves the IP address up or down in the IP address list.</td>
</tr>
<tr>
<td></td>
<td>The discovery is performed in the order of the addresses in the IP address list.</td>
</tr>
<tr>
<td>Restore default settings</td>
<td>Click this to clear the IP address list and disable discovering using IP addresses.</td>
</tr>
</tbody>
</table>

**Specifying an IP address range**

Discovers the specified IP address range for the device using unicast. You can perform this discovery when an IP address is assigned to the device.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable discovery with an IP address range</td>
<td>Select to enable this discovery condition.</td>
</tr>
<tr>
<td>Add</td>
<td>Displays the screen where you can set an IP address range.</td>
</tr>
<tr>
<td></td>
<td>Enter the start and end IP addresses for the range you want to discover in IPv4 format.</td>
</tr>
<tr>
<td></td>
<td>You can register a range of up to 20 IP addresses. You cannot register the discovery if the number of the IP address range exceeds 65536.</td>
</tr>
<tr>
<td>Change</td>
<td>Changes the IP address range specified for the device selected in the discovery range.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the IP address range specified for the device selected in the discovery range.</td>
</tr>
<tr>
<td>Restore default settings</td>
<td>Click this to clear the discovery range and disable discovering using a range of IP addresses.</td>
</tr>
</tbody>
</table>

**Specifying a network address**

Discovers a device in the specified network address using multicast.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable discovery with multicast</td>
<td>Select this to send data to the specified network using port number 427 and multicast to discover a device. You need a router environment that supports IP multicast.</td>
</tr>
<tr>
<td>Enable discovery over network segments</td>
<td>Select this to discover devices on networks beyond your router. Sends data to the specified network using port number 3289 and broadcast to discover a device. When sending using multicast, you can set the network range to be discovered in Multicast TTL (1-15).</td>
</tr>
</tbody>
</table>
Installation Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Displays the screen where you can specify a network address. Enter a network address and subnet mask in the subnet in IPv4 format. When the entered network address is the host address, it is automatically corrected and registered to the discovery address list. You can register up to 20 network addresses.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected network address and subnet mask from the discovery address list.</td>
</tr>
<tr>
<td>Multicast TTL (1-15)</td>
<td>Sets the network range to be searched when sending by multicast. When set to “1”, the router is not passed through. When set to “2” or higher, the network range specified in Network to discover is discovered.</td>
</tr>
<tr>
<td>Restore default settings</td>
<td>Click this to clear the discovery range and disable discovering using a range of IP addresses.</td>
</tr>
</tbody>
</table>

Specifying individual devices

You can register devices that were not found using the discovery feature, or devices that were not made by Epson.

1. Select Devices on the side bar task menu.
2. Click Device List - Add on the ribbon menu.
3. Select a method to classify the device.
   - Select IP Address when the device has a static IP address.
   - Select DNS Name when the IP address for the device is set automatically.
4. Enter the device information.
   - Enter the IP address in IPv4 format when you select IP Address as the method.
   - Enter the device name on the network when you select DNS Name as the method.
5. Click OK.
   - When communication is successful, the device is registered to the device list.
   - If it is not registered, make sure the IP address and domain name are correct.
Updating Device Information

You can update detailed information about the status of devices registered in the device list and the status of consumables. The ribbon menu is unavailable when device information is being acquired.

1. Select Devices on the side bar task menu.
2. Click Update Device Information - All Devices on the ribbon menu.
   
   When updating data individually, select the device from the device list, and then click Update Device Information - Selected Devices.

   **Note:**
   To make multiple selections, press Ctrl or Shift and click your mouse.

You can update device information automatically.

- Update when starting Epson Device Admin
  
  Select Options - Startup - Device Management - Update device data at startup.

- Update regularly by using a timer
  
  You can update data regularly by setting a schedule. See the following for details.

  ➔ “Collecting information regularly” on page 69

Group Management

You can manage devices registered to the device list as separate groups. The groups are displayed in the tree view when you select Devices on the side bar task menu.

You can create groups for specific purposes, such as the location devices are installed, organization names, different features of the printer or scanner, available paper sizes, and then manage the devices as groups.

You can use the following methods to register devices to a group.

- Assign automatically using set conditions
  
  Discovered devices are assigned automatically using set conditions.

- Select devices
  
  Select devices and register them to a group. You can create a group from the selected devices.

Create and edit user-defined groups

You can manage devices as a group by creating optional groups such as for the office and department of the device.
Create an automatic assignment group

Devices discovered through a search are automatically assigned to a group. Follow the steps below to set the conditions for assigning groups.

**Note:**
You can create up to 2,000 groups. There is no limit for groups in the same layer.

1. Select **Devices** on the side bar task menu.
2. Click the **Groups** tab on the ribbon menu.
3. Click **New**.

4. Select the group name to use as the parent from **Parent group**.
   When creating a new group, layers are created by assigning the **User Defined Groups** as the parent group. You can create up to eight layers of groups.

5. Enter the new group name in **Group Name**.
Installation Settings

Enter up to 256 characters in Unicode for the group name. You cannot use \ or ;.

Click **Enable auto filter**.

Click **Add**.

The setting screen for automatically assigning groups is displayed.

Set the auto assignment conditions.

You can register up to 20 conditions.

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Information</td>
<td>Items in the device list column. Select the following from the pull-down menu.</td>
</tr>
<tr>
<td></td>
<td>- Model</td>
</tr>
<tr>
<td></td>
<td>- IP address</td>
</tr>
<tr>
<td></td>
<td>- Department</td>
</tr>
<tr>
<td></td>
<td>- Location</td>
</tr>
<tr>
<td></td>
<td>- Remarks</td>
</tr>
<tr>
<td></td>
<td>- Groups</td>
</tr>
</tbody>
</table>

6

7

8
### Installation Settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditions</td>
<td>Select conditions for the target items.</td>
</tr>
<tr>
<td></td>
<td>- When <strong>Device Information</strong> is set to <strong>IP Address</strong>:</td>
</tr>
<tr>
<td></td>
<td>- Greater than or equal to</td>
</tr>
<tr>
<td></td>
<td>- Less than or equal to</td>
</tr>
<tr>
<td></td>
<td>- Greater than</td>
</tr>
<tr>
<td></td>
<td>- Less than</td>
</tr>
<tr>
<td></td>
<td>- Equal to</td>
</tr>
<tr>
<td></td>
<td>- Not equal to</td>
</tr>
<tr>
<td></td>
<td>- Start with</td>
</tr>
<tr>
<td></td>
<td>- When <strong>Device Information</strong> is set to <strong>Model, Department, Location, or Remarks</strong>:</td>
</tr>
<tr>
<td></td>
<td>- Equal to</td>
</tr>
<tr>
<td></td>
<td>- Not equal to</td>
</tr>
<tr>
<td></td>
<td>- Include</td>
</tr>
<tr>
<td></td>
<td>- Not include</td>
</tr>
<tr>
<td></td>
<td>- Start with</td>
</tr>
<tr>
<td></td>
<td>- End with</td>
</tr>
<tr>
<td></td>
<td>- When <strong>Device Information</strong> is set to <strong>Groups</strong>:</td>
</tr>
<tr>
<td></td>
<td>- Belong</td>
</tr>
<tr>
<td></td>
<td>- Not Belong</td>
</tr>
<tr>
<td>Value</td>
<td>When <strong>Device Information</strong> is set to <strong>IP Address</strong>, enter the IP address.</td>
</tr>
<tr>
<td></td>
<td>For other situations, enter up to 256 characters in Unicode.</td>
</tr>
<tr>
<td>Operation</td>
<td>Selects the relationship to the last condition. The conditions are applied in order from the top of the auto sorting conditions.</td>
</tr>
</tbody>
</table>

Click **OK**.
Installation Settings

The automatic assignment condition is added in the list.

To continue adding the auto assign groups, click **Add**.

Click **Edit** to edit the group in the list.

Click **Delete** to delete the group from the list.

Click ∧ or ∨ to change the order of the conditions.

Click **OK**.

The newly created group is added to the tree view.

**Add a device by creating a group**

Register devices to the group after creating the group.

**Note:**

*You can create up to 2,000 groups. There is no limit for groups in the same layer.*

1. Select **Devices** on the side bar task menu.
2. Click the **Groups** tab on the ribbon menu.
3. Click New.

4. Select the group name to use as the parent from Parent group.

When creating a new group, layers are created by assigning the User Defined Groups as the parent group. You can create up to eight layers of groups.

5. Enter a new group name in Group Name.

Enter up to 256 characters in Unicode for the group name. You cannot use \ or ;.

6. Click OK.
The new group is added to the tree view.

Click Add/Remove device(s) on the ribbon menu.

Select the group to which you want to add the device, and then click Next.

The device list is displayed.

Select the device you want to register.

Select devices to register by Select devices and then click >.
Installation Settings

**Note:**
To delete devices from the list, select the device in Added devices, and then click <.

10 Click OK.

**Group editing**

Change group names and parent groups in higher layers.

1 Select Devices on the side bar task menu.

2 Click the Groups tab on the ribbon menu.

3 Click Edit.
Installation Settings

4. Select the group name to be edited from Parent group.

![Edit group dialog box](image)

5. Change the group name in Group Name.

If you want to change parent groups, enter the name from the parent group name.

![Edit group dialog box](image)

6. Click OK.

The changes are reflected in tree view.

![Tree view](image)
Deleting a group

1. Select Devices on the side bar task menu.

2. Click the Groups tab on the ribbon menu.

3. Click Delete.

4. Click OK.

A screen is displayed asking you to confirm if you want to delete the group.

Deleting a group automatically deletes its sub-groups if there are any.

5. Click OK.

The changes are reflected in tree view.

Devices from deleted groups are displayed in Ungrouped Devices.
Device Management

This section explains how to configure one device at a time, and how to configure batch settings for multiple devices.

Device Settings

Configure settings for devices on the network individually or collectively. Apply configuration information as a template or manage devices by exporting configuration information to a SYLK file.

See the following for details about the available methods.

Configuration template
☞ “Settings Template” on page 43

Device properties and Embedded web server
☞ “Setting or changing devices one at a time” on page 51

Batch Settings
☞ “Batch Settings” on page 113

Settings Template

Set devices using a configuration template. A configuration template uses the device’s property settings as a template, and then applies the settings to other devices. You can manage setting information without relying on specific devices.

The following templates are provided as presets.

- Factory default settings (Network I/F)
  Return the network interface settings for devices to their default settings.

- Factory default settings (All)
  Return all settings for devices to their default settings.

Creating a configuration template

Divert the device settings, and then create templates.

- Create from configuration template management screen
  Create by selecting a device to use as a configuration template.

- Create from device management screen
  Create by selecting a device to use as a configuration template from the device list.
Creating from the configuration template management screen

1. Select Configuration on the side bar task menu.
2. Click Save as Template.

The device selection screen is displayed.

3. Select the base device to be used to create settings.

You can select groups to which devices are registered from the Select group(s) menu.

The base device must support unicast communication and the functions to be set.

4. Click OK.

The configuration template information edit screen is displayed.
Device Management

5 Enter information for each item.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Template Name</td>
<td>Name of the configuration template. Enter up to 1,024 characters in Unicode (UTF-8).</td>
</tr>
<tr>
<td>Author</td>
<td>Information on the creator of the template. Enter up to 1,024 characters in Unicode (UTF-8).</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter optional information. Enter up to 1,024 characters in Unicode (UTF-8).</td>
</tr>
</tbody>
</table>

6 Select the check boxes next to the items to be setting values.

Note:
Some items are for writing only, and cannot be collected from the device and these fields are left empty. To make these settings, you need to enter a value manually.
Device Management

Click Save.

The template is saved.

Creating from the device management screen

1. Select Devices on the side bar task menu.

2. Select the base device to be used to create settings from the device list.

   The base device must support unicast communication and the features to be set.

3. Click Save as Configuration Template on the ribbon menu.

   The configuration template information edit screen is displayed.

   ![Device Management Screen]

   **Note:**
   
   You can also select from the menu displayed when you right-click the selected device.

4. Enter information on the configuration template.

   See step 5 in the last item for details.

5. Change setting values as necessary, and then select the items you want to save to the template.

6. Click Save.

   The template is saved.

Applying configuration template

You can apply setting information to groups or individual templates by using a configuration template.

Items used to set target devices with the selected configuration template are applied.

You can apply settings using the following methods.

- Select devices and apply

  Select devices from the device list, and then select the configuration template. You can select devices to be applied by confirming device information in the list.

- Select configuration template and apply

  Select a configuration template from the configuration template management screen, and then select devices. You can check the content of configuration templates in the list.
Select devices and apply

1. Select Devices on the side bar task menu.

2. Select the devices to which you want to apply the configuration template from the device list.

   **Note:**
   To make multiple selections, press **Ctrl** or **Shift** and click your mouse.

3. Click Apply Configuration Template on the ribbon menu.

   The device selection screen is displayed.

   **Note:**
   You can also select from the menu displayed when you right-click the selected device.

4. Select the configuration templates you want to apply from **Select a configuration template**.

5. Check that the devices to which you want to apply the configuration template are in the list.

   The devices to which the settings will be applied are in the Selected Target list. To change these, move devices or groups by using ▶️, ◀️, ◀️, ◀️, and ◀️.

   Use ▶️ to move the selected device or group, and use ◀️ to move all devices or groups.
Device Management

Note:
- When you select Devices and groups containing devices from the pull-down menu, each device is displayed.
- Groups are displayed when you select Groups.

6 Click Apply.

A confirmation screen for the configuration template to be applied is displayed.

7 Click OK.

A confirmation screen for the application results is displayed.

8 Check the content, and then click Close.

You can check detailed information by clicking Details.

Select configuration templates and apply

1 Select Configuration on the side bar task menu.

2 Click Apply.
The device selection screen is displayed.

3. Select the configuration template you want to apply from Select a configuration template.

4. Select the devices to which the configuration template will be applied.

The devices to which the settings will be applied are in the Select Target list. To change these, move devices or groups by using >, >>, <, and <<.

Use > to move the selected device or group, and use >> to move all devices or groups.
Click **Apply**.

A confirmation screen for the configuration template to be applied is displayed.

Click **OK**.

A confirmation screen for the application results is displayed.

Check the content, and then click **Close**.

You can check detailed information by clicking **Details**.

---

**Editing configuration templates**

You can change, duplicate, and delete a saved configuration template.

**1.** Select **Configuration** on the side bar task menu.

**2.** Select the configuration template you want to edit.
Device Management

3. Click **Edit**, **Duplicate**, or **Delete** on the ribbon menu.

4. Edit the configuration template.
   
   You can perform the following actions for each item.
   
   - **Edit**
     
     Change the setting values for the selected configuration template.
     
     Click **OK** to save your edits.
   
   - **Duplicate**
     
     Creates a copy of the selected configuration template.
     
     Edit the configuration template name in the text box as necessary. Click **OK** to save the copied template.
   
   - **Delete**
     
     Deletes the selected configuration template.
     
     You cannot delete preset configuration templates. The selected configuration template is deleted when you click **OK** on the confirmation screen.

Exporting and importing configuration templates

You can export and import a saved configuration template. You can use this for maintenance or backup. See the following for details.

“Configuration templates” on page 107

Setting or changing devices one at a time

Device properties screen

Configure one device at a time by using the Device Properties screen.

**Note:**

You cannot configure the device while acquiring device information using the schedule function.

1. Select **Devices** on the sidebar task menu.

2. Click the **Home** tab on the ribbon menu.
Select the device you want to configure from the device list.

**Note:**
When you select multiple devices, you cannot configure them. If you want to configure more than one device, use the Configuration Template or the Batch Setting function.

Settings Template” on page 43

Click **Device Configuration**.

The Device Properties screen is displayed.

When the password entry screen is displayed, enter the password, and then click **OK**.

Set each item as necessary.

Set the device to match the environment being used. Displayed items differ depending on the model being used.

See the following for the setting methods for each item.

Epson Device Admin Help "Device Properties"

Click **Transmit** to set the necessary items.
Device Management

7 Click OK.

When the password entry screen is displayed, enter the password, and then click OK.

Transmit the settings.

**Note:**
- The information is transmitted to the device, and then the message “Configuration successfully completed.” is displayed. Do not turn off the device or the wireless adapter, and do not send any data to the device.
- See the following when setting the password.
  “Setting an Administrator Password” on page 54

8 Click OK.

9 It can take up to three minutes until the settings are enabled. Do not turn off the device or wireless adapter during this time.

The  icon is displayed in the device list while setting up the device.

- If the  icon remains after three minutes has passed, check the status of the device or the wireless adapter.
- If the ! icon is displayed, communication with the IP address could not be completed. Check that the IP address is enabled in the environment being used.

**Using an embedded web server to make device settings**

You can run Embedded Web Server (Web Config, EpsonNet Config (Web), or Remote Manager) when an IPv4 IP address is set to allow unicast communication.

1 Select Devices on the side bar task menu.
Device Management

Click the **Home** tab on the ribbon menu.

Select the device you want to configure from the device list.

**Note:**
When you select multiple devices, you cannot configure them. If you want to configure more than one device, use the Configuration Template or the Batch Setting function.

“Settings Template” on page 43

Click **Embedded Web Server**.

The Embedded Web Server is displayed.

**Note:**
- If you cannot select Launch Browser, check that the IP address has been changed from its default setting, or that the IP address is not already in use.
- The message “There is a problem with this website’s security certificate.” may be displayed when running the embedded web server. (The message varies depend on the browser.) This is displayed because the device uses SSL communication (encrypted communication) to protect your personal information. Click “Continue to this website (not recommended).”.

Set each item as necessary.

Set the device to match the environment being used. Displayed items differ depending on the model being used.

**Setting an Administrator Password**

You can use an administrator password to protect device settings. The password is not set by default.

**Setting individually**

Configure one password at a time by using the Device Properties screen.

Select **Devices** on the side bar task menu.

Select the device you want to configure from the device list.

If the device is not displayed, check that the device or wireless adapter is turned on, or if the device is in the same segment as the computer.

Click **Device Configuration** on the **Home** tab in the ribbon menu.
Click **Administrator Settings - Password**, and then click **Change**.

![Screenshot of Administrator Settings window]

Enter the password in **New Password** and **Reenter New Password**, and then click **OK**.

![Screenshot of Administrator Password window]

Click **Transmit** to set the necessary items.

It can take up to three minutes until the settings are enabled. Do not turn off the device or wireless adapter during this time.

**Note:**

- The device passwords are shared with each application used in network settings. Make sure you manage the password carefully.
- If you forget the password, see the documentation provided with the device to restore the default settings. Also, the password is not reset even if the device's built-in network I/F is returned to its default settings.

### Managing passwords in batches

You can save the password for devices in Epson Device Admin.

### Managing passwords automatically

You can change settings without having to enter device's password the next time once an administrator password is authenticated. Password information is saved to the data base of this software, and the software refers to the device's MAC address after authentication.
You do need to enter the password when changing passwords of devices after saving password information. When the revised password is authenticated, saved password information is updated.

**Note:**
This function is not accessible when batch settings or firmware update are in progress.

1. Select **Devices** on the side bar task menu.
2. Click **Options** on the ribbon menu.
3. Select **Password manager**.
4. Select **Enable automatic password management**.
5. Click **OK**.

### Setting a master password

You need to set a master password to display the passwords set for devices in the password list.

#### Creating a new master password

Set a new master password. Once it has been set, you need to enter the password if you change it.

1. Select **Options - Password manager**.
2. Select **Use master password**.
The change master password screen is displayed.

Enter the master password in **New password** and **Confirm new password**.

Enter the password you want to set using up to 20 ASCII characters.

Click **OK**.

**Changing the master password**

You need to enter the password to change the master password settings.

**Note:**

You also need to enter the password when you clear **Use master password**.

1. Select **Options - Password manager**.
2. Click **Change Master Password**.
Device Management

The change master password screen is displayed.

Enter the current master password in Current password.

Enter the new master password in New password, and then enter the same password in Confirm new password.

Enter the password you want to set using up to 20 ASCII characters.

Click OK.

Editing an administrator password using the list

You can edit the administrator password for a device using the password management list.

See the following for details on backing up and restoring the password management list.

☞ "Password settings" on page 100.
**Device Management**

**Adding and editing a password**
Add or change an administrator password.

1. Select **Options - Password manager**.
2. Click **Password manager**.

The password management screen is displayed.

**Note:**
*When a master password is set you need to enter the password.*

3. Click **Add** when setting a new password, and when changing settings select devices and then click **Edit**.

The add password screen is displayed.

**Note:**
- You can change the group display for devices in **Group**.
- When **Use master password** is selected, **Display password(s)** is displayed. When it is selected, the password column is added and passwords are displayed.
Device Management

4 When making new settings, enter the MAC address for the device.
   When changing settings, the registered MAC address is displayed and cannot be edited.

5 Enter any password in **Password**, and then enter the same password in **Confirm new password**.
   Enter the password you want to set using up to 20 ASCII characters.

6 Select the check-box next to the device that you want to manage.
   **Selected**: Enables automatic authentication and password saving.
   **Cleared**: Disables automatic authentication and password saving.

Registering Different Address Books

You can import email addresses, target folders, abbreviated fax numbers from a product and edit the data.

Editing individually

See the following for the batch setting function.

☞ “Making batch settings” on page 63
Device Management

Note:
This function is only available for supported models.

1. Select Devices on the side bar task menu.
2. Select the device you want to configure from the device list.
3. Click Device Configuration on the Home tab on the ribbon menu.
4. Click the item you want to edit from the following. Displayed items differ depending on the device being used.
   - Common - Contacts
   - Scan - Mail Settings
   - Scan - Target Folder
   - Fax - Reception - FAX to Folder
   - Fax - Reception - E-Mail
   - Fax - Fax Number

Note: This function is only available for supported models.
Device Management

See the following for detailed information on each item.

Epson Device Admin Help "Device Properties"

5 Select the number you want to edit, and then click **Edit**.

**Edit** is not displayed on the fax Folder screen. Go to step 6.

Screen for **Target Folder**.

6 Set each item, and then click **OK**.
Device Management

OK is not displayed on the fax Folder screen. If setup is complete, go to step 7.

If all settings are complete, click Transmit.

When a confirmation screen is displayed, click OK to start transmitting the settings.

Click OK to complete transmission.

Making batch settings

Creating a settings file

You can save and edit information for the same item.

You can save information that includes security items such as private information by setting a password. You cannot edit this file. See the following page for more details.

"Exporting by setting a password" on page 103

1. Select Devices on the side bar task menu.

2. Select the device you want to configure from the device list.

3. Click Device Configuration on the Home tab on the ribbon menu.

4. Click the item you want to edit. Displayed items differ depending on the device being used.

- Common - Contacts
- Administrator Settings - Access Limitation
Device Management

- Scan - Mail Settings
- Scan - Target Folder
- Fax - Reception - E-Mail
- Fax - Fax Number

See the following for detailed information on each item.

Epson Device Admin Help "Device Properties"

5. Click Export.

Screen for Contacts.

6. Select Normal Export, and then click OK.

7. Enter a file name, and then click Save.
A SYLK format file is saved with the extension ".slk".

Open the SYLK file you saved in a spreadsheet application such as Microsoft Excel or in a text editor, and then edit the information.

Save the edited SYLK format file.

Reading the settings file

The software can read edited settings files.

See the following for details on binary files that include security items such as passwords and private information.

“Importing files containing security information” on page 105

Select Devices on the side bar task menu.

Select the device you want to configure from the device list.

Note:
To make multiple selections, press [Ctrl] or [Shift] and click your mouse.

Click Device Configuration on the Home tab on the ribbon menu.

Click the item you want to edit from E-Mail, FAX to Folder, Fax Number. Displayed items differ depending on the device being used.
5 Click **Import**.

Screen for Fax Number.

6 When the "Start Import Wizard Confirmation" message is displayed, click **OK**.

7 Set the path to the file you want to import, and then click **Next**.

Click **Browse**, and then select the SYLK file (*.slk) containing information such as email addresses or registered user information for the Access Limitation function, and then click **Open**.

**Note:**

CSV (*.csv) format files can also be imported.
Device Management

8. Click Transmit.

9. When a confirmation screen is displayed, click OK to start transmitting the settings.

10. Click OK to complete transmission.

Updating Device Firmware

You can check for the latest firmware and then update the device’s firmware if necessary.

Updating firmware

Check the firmware version site for the device, and update the firmware if necessary. Updates can only be performed for devices that support the features registered to the device list.

Before updating you need to make settings to allow access to external sites.

☞ “Check for updates” on page 28.
Device Management

1. Select **Devices** on the side bar task menu.

2. Click the **Home** tab on the ribbon menu.

3. Select **Check Updates**.

   Access external site to check for updates.

   ![Device Management Interface](image)

   Display in the device list when firmware is updated.

4. Select devices in the device list to update firmware.

5. Click **Update**.

   Firmware is updated.

**Note:**

*If Check for the latest firmware in Options - Access to external websites is not selected, firmware version is not checked.*
Daily Management

This chapter explains how to make preparations for daily management.

When you have set schedules for acquiring device information and alert notifications, this software collects device information and monitors devices automatically, and then sends you a notification if a problem occurs.

By making report settings, since this software collects device data for specified periods, you can check the frequency the device is used and the status of consumables.

Managing the Device List

Collecting information regularly

You can update device information regularly by using Auto Refresh.

Schedule settings

Set the time interval for regularly collecting information.

1. Select Devices on the side bar task menu.
2. Click Options on the Home tab on the ribbon menu.
3. Click Timing.
4. Set the interval to collect information.
Daily Management

- **Refresh interval**
  Collects device information at regular intervals after starting Auto Update.
  You can set the interval in units of one minute from 1 minute to 23 hours 59 minutes.

- **Select the day of the week**
  Collects device information on a specified day and time.
  You can specify Monday through Sunday, and the time in minutes.

5 Click OK.

Starting Auto Update

Start Auto Update.

1 Select Devices on the side bar task menu.

2 Click Auto-Update on the Home tab on the ribbon menu.

Auto Refresh is started.

Note:
You can cancel data collection using a schedule by clicking the icon at the bottom-right of the screen. The schedule settings are canceled at the same time.

Displaying the device list settings

You can customize the display for the device list.

The following customizations are available.

- **Display presets**
  Frequently used presets are provided by default.
  You can also save the current display as a preset.

- **Edit columns**
  You can edit columns, and display only those columns you need.

- **Filtering**
  You can filter target devices by filtering the column displayed using a character string.
Display presets

You can switch the display by using the menu on the View tab on the ribbon menu on device management screen.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic View</td>
<td>Displays the default presets.</td>
</tr>
<tr>
<td>Default, Supplies, Counts</td>
<td>Default settings view. Displays consumables and the number of prints.</td>
</tr>
<tr>
<td>User Defined</td>
<td>Displays registered preset in a pull-down menu.</td>
</tr>
</tbody>
</table>

Registering a preset

You can register the items for the current device list as a preset. You can register up to 256 items.

1. Select Devices on the side bar task menu.
2. Convert the display of the device list to the display registered as preset.
3. Click Add as Preset on the View tab on the ribbon menu.
4. Enter the name of the preset, and then click OK.
   Enter up to 255 characters in Unicode.

   Note: You can select the name of an existing preset, and overwrite the settings by clicking OK on the confirmation screen.

Editing presets

You can change or delete the name of a registered preset or set the default preset.

1. Select Devices on the side bar task menu.
Daily Management

2 Click **Edit Preset** on the **View** tab on the ribbon menu.

3 Use the buttons to change the preset settings.

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition view list</td>
<td>Displays user-defined presets. The default preset is displayed in bold.</td>
</tr>
<tr>
<td>, ,  ,</td>
<td>Moves the selected preset to up or down the list.</td>
</tr>
<tr>
<td>Change Name</td>
<td>Changes the name of the selected preset.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected preset.</td>
</tr>
<tr>
<td>Set as Default</td>
<td>Sets the selected preset as the default. This is assigned to the <strong>Default</strong> button on the ribbon menu.</td>
</tr>
</tbody>
</table>

4 Click **OK**.

**Editing columns**

You can change the way columns are displayed in the device list.

1 Select **Devices** on the side bar task menu.

2 Click **Edit Column** on the **View** tab on the ribbon menu.

3 Use the buttons to change the preset settings.
Daily Management

The item **Selected column(s)** is displayed in the device list.

You can add the amount of remaining consumables, the number of times consumables have been replaced, and the number and type of printed pages (A4, A3, Color, B&W).

![Available Column and Selected Column windows]

**Note:**
The actual display items may differ depending on the device being used.
- The number of prints contains paper jams, print mistakes, and status sheets.
- Depending on the timing for data collection, there may be errors in the total number of prints.
- The amount of ink remaining and replacement times are displayed in Gray for Dark Gray and in Light Gray for Light Gray depending on the device being used.
- The remaining amount of consumables is approximate.
- For ink injection devices, the amount of ink remaining and the ink replacement times are displayed as numbers when performing operations as explained in the manual.
- Ink and toner with the same color are displayed in the same item.
- Ink for devices with sets of two colors that are the same is displayed as (C1) and (C2).

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Select the category for basic information and consumables for items displayed in <strong>Available Column</strong>.</td>
</tr>
<tr>
<td>&gt;, &lt;</td>
<td>Moves the selected item to the column on the left or right.</td>
</tr>
<tr>
<td>∧, ∨</td>
<td>Moves the position the item is displayed up or down the list.</td>
</tr>
</tbody>
</table>

4 Click **OK**.

**Using filters**

By entering keywords in the **Apply Filter** text box on the ribbon menu, you can display devices containing the same character string in the device list.
Daily Management

Enter up to 255 characters in Unicode. The software does not distinguish between upper and lower case characters.

To cancel the filter, delete the character string from the text box.

Managing Alerts

You can monitor alerts from devices and send notifications to set email addresses depending on the type of alert.

To use the alert feature, set the type of alert and the email recipient, and then connect it to the group of devices to be monitored.

Note:
Use this feature when selecting features during software installation. If it is not already installed, you can set it from the Windows Control Panel. See the following for details.
☞ “Changing features and uninstalling” on page 12

Creating alerts

You can create alerts based on the alert type and email address.

You can create it up to 10,000 items.

1. Select Alerts on the side bar task menu.
2. Click New on the ribbon menu.
Enter the items.

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Name</td>
<td>The name of the alert displayed on the alert list. Enter up to 1,024 characters in Unicode.</td>
</tr>
<tr>
<td>Alert Type</td>
<td>Set the conditions for sending an alert notification. You can select from the following.</td>
</tr>
<tr>
<td></td>
<td>- Paper jam</td>
</tr>
<tr>
<td></td>
<td>- Paper out</td>
</tr>
<tr>
<td></td>
<td>- Supplies level low</td>
</tr>
<tr>
<td></td>
<td>- Supplies level warning</td>
</tr>
<tr>
<td></td>
<td>- Service call problem</td>
</tr>
<tr>
<td>To</td>
<td>Enter the email address to which alert notifications are sent. When entering multiple addresses, separate the addresses with semi-colons (;). You can enter up to 32,767 bites including ;. Enter all addresses in the [TO] field. You cannot use the [CC] or [BCC] fields. You can select and insert multiple addresses that you have entered previously by clicking [Select from history].</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject of the alert notification email. You can enter up to 256 characters.</td>
</tr>
<tr>
<td>Message</td>
<td>The text of the alert notification email. You can enter up to 64K bites.</td>
</tr>
</tbody>
</table>

Click OK to save the alert and close the screen. Click Assign/Remove Group(s) to set monitored groups using the created alert.

When you click OK, the alert is created and added to the alert list.

When you click Assign/Remove Group(s), you can add groups to be monitored by alerts. See the following for details.
Adding groups monitored by alerts

You can set monitored groups with the created alert. This sends notifications when an alert is generated on a device in the group.

1. Select Alerts on the side bar task menu.
2. Selects alert from the alert list.

You cannot add monitoring groups when selecting multiple templates.

3. Click Assign/Remove Group(s) on the ribbon menu.

4. Select the group you want to monitor, and then click > to move it to Subscribed Group(s).
   When you move a group to Unsubscribed group(s) by clicking <, alert monitoring is canceled.

5. Click OK.
   Alert monitoring for devices in the selected group begins.

   Note:
   You can set multiple alerts for one group. Add the alerts to each monitoring group.

Setting the alert confirmation interval

You can set the interval to check alerts from the device.

1. Select Devices on the side bar task menu.
Daily Management

2 Click Options on the Home tab on the ribbon menu.

3 Select Alert Notifications.

4 Set the interval to check for alerts.

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval to check for alerts [1–600]</td>
<td>Set the interval to check for alerts on devices. Enter 1 to 600 seconds in intervals of 1 second.</td>
</tr>
<tr>
<td>Notification email resend interval</td>
<td>Sets the time to resend a notification email that an alert has occurred if the alert is not cleared from a device. Select from the following. 5 minutes/10 minutes/30 minutes/1 hour/3 hours/6 hours/12 hours/1 day/2 days/3 days/4 days/5 days/1 week</td>
</tr>
</tbody>
</table>

Editing alerts

You can change, duplicate, and delete alerts you created.

1 Select Alerts on the side bar task menu.

2 Select an alert from the alert list.

You can only select multiple alerts when deleting.
Daily Management

Set using the screen displayed when you click the button on the ribbon menu.

- Change: **Edit**
  
  Displays the alert screen. Change the settings, and then click **OK**.

- Copy: **Duplicate**
  
  Displays the alert name screen. Enter a new name, and then click **OK**.

- Delete: **Delete**
  
  Displays the delete confirmation screen. To delete the alert, click **OK**.

Switching the alert display

You can switch the alert list and the log screen when clicking the item in the tree view.

The number next to the item name is the number of alerts in the item.

Alert list

Displays a list of alerts at the top.

- All
  
  Displays all alerts.

- Subscribed Alerts
  
  Displays alerts that have been subscribed to at least one group.

- Unsubscribed Alerts
  
  Displays alerts that have not been subscribed to any groups.
Daily Management

Log

When you select Logs from the tree view, a log of alert notifications are displayed at the top, and detailed content is displayed at the bottom.

You can set the time to save logs in Log retention period from Options - Timing.

Report Management

Report management allows you to output the status of devices, consumables, and accessories as a report.

You can create reports by using the Wizard.

Note:

- Use this feature when selecting features during software installation. If it is not already installed, you can set it from the Windows Control Panel. See the following for details.
  - “Changing features and uninstalling” on page 12
- If your computer is set to daylight saving time, errors may be generated during data collection and timed intervals for reports.

Creating reports

You can create reports for target device groups using the conditions for the selected report format. You can create the report by specifying a period or setting a regular schedule. Create device groups before creating reports.

“Group Management” on page 33

1. Select Reports on the side bar task menu.
2. Select User Defined Report - Scheduled reports from the tree view.
3. Click New on the ribbon menu.

The report creation Wizard is displayed.
Daily Management

Set conditions when acquiring report data.

Select from the following.

Device Usage / Hourly peak usage / Supply Usage / Accessory Inventory

Select the conditions used to create a report by specifying the period or setting a schedule.

Create report by specifying a period: Clear the **Create a Schedule** check box.

Create report by setting the schedule: Select the **Create a Schedule** check box.

Click **Next**.

Select the target device group.

Target groups are listed in the box on the right. To change these, move groups by using >, >>, <, and <<.
Daily Management

You can move selected groups by using > , < , and all groups by using >>, <<.

Click Next.

Specify the report format.

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>Sets the file format for the report. You can select PDF, HTML, or CSV.</td>
</tr>
</tbody>
</table>
Available items for collection conditions

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary sort</td>
<td>Select the key given first priority when sorting reports using device information items. You can select from the following.</td>
</tr>
<tr>
<td></td>
<td>❑ Model</td>
</tr>
<tr>
<td></td>
<td>❑ IP address</td>
</tr>
<tr>
<td></td>
<td>❑ MAC address</td>
</tr>
<tr>
<td></td>
<td>❑ None</td>
</tr>
<tr>
<td>Secondary sort</td>
<td>Select the key given second priority when sorting reports using device information items. Available items are the same as for Primary sort.</td>
</tr>
<tr>
<td>Device Information</td>
<td>Select the device information items to be included in the report. You can select from the following.</td>
</tr>
<tr>
<td></td>
<td>❑ Model</td>
</tr>
<tr>
<td></td>
<td>❑ MAC address</td>
</tr>
<tr>
<td></td>
<td>❑ IP address</td>
</tr>
<tr>
<td></td>
<td>❑ Serial Number</td>
</tr>
<tr>
<td></td>
<td>❑ Firmware version</td>
</tr>
<tr>
<td></td>
<td>❑ Location</td>
</tr>
<tr>
<td>Data Column</td>
<td>Select the collection data to be included in the report. See the following table for the available items.</td>
</tr>
</tbody>
</table>
**Daily Management**

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device Usage</strong></td>
<td>You can select information for compatible paper sizes.</td>
</tr>
<tr>
<td></td>
<td>- Total pages:</td>
</tr>
<tr>
<td></td>
<td>The total number of pages printed are tracked by the printer engine.</td>
</tr>
<tr>
<td></td>
<td>- Mono pages:</td>
</tr>
<tr>
<td></td>
<td>The total number of black-and-white pages printed are tracked by the printer engine.</td>
</tr>
<tr>
<td></td>
<td>- Color pages:</td>
</tr>
<tr>
<td></td>
<td>The total number of color pages printed are tracked by the printer engine.</td>
</tr>
<tr>
<td></td>
<td>- 1-sided pages:</td>
</tr>
<tr>
<td></td>
<td>The total number of simplex pages printed are tracked by the printer engine.</td>
</tr>
<tr>
<td></td>
<td>- 2-sided pages:</td>
</tr>
<tr>
<td></td>
<td>The total number of duplex pages printed are tracked by the printer engine.</td>
</tr>
<tr>
<td></td>
<td>- 1-sided mono pages:</td>
</tr>
<tr>
<td></td>
<td>The total number of simplex black-and-white pages printed are tracked by the printer engine.</td>
</tr>
<tr>
<td></td>
<td>- 1-sided color pages:</td>
</tr>
<tr>
<td></td>
<td>The total number of simplex color pages printed are tracked by the printer engine.</td>
</tr>
<tr>
<td></td>
<td>- 2-sided mono pages:</td>
</tr>
<tr>
<td></td>
<td>The total number of duplex black-and-white pages printed are tracked by the printer engine.</td>
</tr>
<tr>
<td></td>
<td>- 2-sided color pages:</td>
</tr>
<tr>
<td></td>
<td>The total number of duplex color pages printed are tracked by the printer engine.</td>
</tr>
<tr>
<td></td>
<td>- Total Prints (m):</td>
</tr>
<tr>
<td></td>
<td>The total printed length is calculated by the printer engine (m).</td>
</tr>
<tr>
<td></td>
<td>- Total Prints (m2):</td>
</tr>
<tr>
<td></td>
<td>The total printed area is calculated by the printer engine (m2).</td>
</tr>
</tbody>
</table>

**Note:**  
The total page count in the report may differ from the actual total page count due to the timing for data collection.

<table>
<thead>
<tr>
<th>Item</th>
<th>You can select the same items as in <strong>Device Usage</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly peak usage</td>
<td></td>
</tr>
<tr>
<td>Supply Usage</td>
<td>Displays the remaining amount of ink/toner.</td>
</tr>
</tbody>
</table>

| Accessory inventory | Memory                                                                 |
|                     | Duplexer                                                               |
|                     | Paper Source                                                           |
|                     | FAX                                                                    |

The following shows the compatible paper sizes for **Device Usage**.

<table>
<thead>
<tr>
<th>UI</th>
<th>Letter</th>
<th>A4/Letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>Letter</td>
<td>A4/Letter</td>
</tr>
<tr>
<td>A3</td>
<td>Ledger</td>
<td>A3/Ledger</td>
</tr>
<tr>
<td>A4</td>
<td>Letter</td>
<td>A4/Letter</td>
</tr>
</tbody>
</table>
Click **Next**.

Specify the report range.

The display may differ depending on the data collection conditions that you selected in step 4.

**When you have selected Device Usage, Supply Usage, or Accessory Inventory:**

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report interval</td>
<td>Select the interval for creating reports from the following.</td>
</tr>
<tr>
<td></td>
<td>- Per Day</td>
</tr>
<tr>
<td></td>
<td>- Per Week</td>
</tr>
<tr>
<td></td>
<td>- Per 2 Weeks</td>
</tr>
<tr>
<td></td>
<td>- Per Month</td>
</tr>
<tr>
<td></td>
<td>- Per Quarter</td>
</tr>
<tr>
<td></td>
<td>- Per Year</td>
</tr>
<tr>
<td>Date range</td>
<td>Specify the report range from the date the report was created or by specifying a date on the calendar. Specify by using a combination of any number over 1 and a day/week/month/year.</td>
</tr>
</tbody>
</table>
When you have selected Hourly peak usage:

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date range</td>
<td>Specify the report range from the date the report was created or by specifying a date on the calendar. Specify by using a combination of any number over 1 and a day/week/month/year.</td>
</tr>
<tr>
<td>Time range</td>
<td>Sets the target period of a report. When setting 24 hours, select All day. When specifying a time, set the start and end times.</td>
</tr>
</tbody>
</table>

Click Next.
Specify email destinations.

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Specify whether or not to send a notification email.</td>
</tr>
<tr>
<td>To</td>
<td>Enter the address to which the alerts are sent.</td>
</tr>
<tr>
<td></td>
<td>When entering multiple addresses, separate the addresses with semi-colons (;). You can enter up to 32,767 bites including (;). Enter all addresses in the [TO] field. You cannot use the [CC] or [BCC] fields.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject of the alert notification email. You can enter up to 256 characters.</td>
</tr>
</tbody>
</table>

Click Next.

Specify a report name.
Daily Management

Name of the report to be output. Enter up to 1,024 characters in Unicode. Enter report name.

Click Next.

Specify a schedule.

**Note:**
If you clear the **Create a Schedule** check box in step 5, this screen is not displayed.

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start date and time</td>
<td>Set the a day to start the schedule. The units are intervals of one minute.</td>
</tr>
</tbody>
</table>
Daily Management

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>End date</td>
<td>Set the day to end the schedule. Select None if you do not want to specify an end day.</td>
</tr>
<tr>
<td>Report Creation Cycle</td>
<td>Specify the interval for creating reports.</td>
</tr>
</tbody>
</table>

Click Next.

Click OK.

The report or schedule is created.

The created report is saved as an archive report.

Acquiring data

You can collect data for devices based on the selected data types. Acquired data is used for reports. You can set the collection start time conditions. See the following for details.

- “Setting the data collection time” on page 89

1 Select Reports on the side bar task menu.

2 Select Database - Data Collection from the tree view.
Daily Management

3. Select the collection conditions from the data collection conditions list.
   You cannot select multiple collection conditions.

4. Click Collect Now on the ribbon menu.

Setting the data collection time and saving period

You can set how long collected data is saved from the option menu on the device management screen.

Setting the data collection time

You can set the collection time depending on the device data collection conditions.

1. Select Devices on the side bar task menu.

2. Click Options on the Home tab on the ribbon menu.


4. Set the start time to acquire data for each condition.
   You can set from 0:00 to 23:59 in minutes.
See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Usage</td>
<td>The time to start collecting data based on the device usage conditions.</td>
</tr>
<tr>
<td>Supplies Usage</td>
<td>The time to start collecting data based on the consumable usage conditions.</td>
</tr>
<tr>
<td>Accessories Inventory</td>
<td>The time to start collecting data based on the accessory installation conditions.</td>
</tr>
</tbody>
</table>

### Setting the data saving period

You can set the period for saving collected data and reports.

1. Select **Options - Timing**.
2. Set **Data retention period**.

   ![Setting the data saving period](image)

- **Devices Data**
  - Sets the period for saving collected data.
  - You can set the period from 1 to 5 in years. Data for which the saving period has expired is automatically deleted.

- **Generated reports**
  - Set the saving period for reports saved in the archives.
  - You can set the period from 1 to 5 in years. Data for which the saving period has expired is automatically deleted.

3. Click **OK**.

### Switching the report display

When you click items in the tree view, you can switch the report management display.
Daily Management

The number of report formats and archived reports is displayed under **User Defined Report**.

### Collecting data

Information on collecting data is displayed in **Database - Data Collection** in the tree view.

- **Conditions for collecting data**
  
  The list of data types is displayed at the top.

  You can set the **Data Collection Times** from the **Options** screen. See the following for details.

  📌 “Setting the data collection time” on page 89

- **Device list**
  
  The device list for collecting data and the device status is displayed at the bottom.

### User defined reports

Displays the information on report management in **User Defined Report** in the tree view.

**Schedule**

Displays the report format and the list of schedules when you select **User Defined Report - Scheduled reports**.
Daily Management

When you select a schedule from the list at the top, the content is displayed at the bottom.

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Data Type</th>
<th>Last Creation Date</th>
<th>Destinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Usage</td>
<td>Device Usage</td>
<td>1/28/2016 8:37 AM</td>
<td><a href="mailto:Admin-report@epson.com">Admin-report@epson.com</a></td>
</tr>
</tbody>
</table>

**Archive report**

Displays the list of archived reports when you select User Defined Report - Archived Reports.

When you select a report, the content of the report is displayed.

Sending archived reports by email

You can send archived reports by email.

1. Select Reports on the side bar task menu.
Select **User Defined Report - Archived Reports** from the tree view.

Select the report you want to send by e-mail from the report list.

**Note:**

To make multiple selections, press Ctrl or Shift and click your mouse.

Click **Email** on the ribbon menu.

The email settings screen is displayed.

Set each item.

See the following to make the settings.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Enter the email address to which you want to send a report. When entering multiple addresses, separate the addresses with semi-colons (;). You can enter up to 32,767 bites including ;. Enter all addresses in the [TO] field. You cannot use the [CC] or [BCC] fields.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject of the report email. You can enter up to 256 characters.</td>
</tr>
<tr>
<td>File format</td>
<td>Sets the file format for the report. You can select PDF, HTML, or CSV.</td>
</tr>
</tbody>
</table>

Click **OK**.

The set content is sent by e-mail.
Saving and deleting archived reports

You can save and delete an archived report.

1. Select Reports on the side bar task menu.

2. Select User Defined Report - Archived Reports from the tree view.

3. Select the report you want to save or delete from the report list.

   You can only select multiple reports when deleting.

   **Note:**
   *To make multiple selections, press Ctrl or Shift and click your mouse.*

4. Click the edit button on the ribbon menu, and then make save settings or confirm that you want to delete the report depending on the screen displayed.

   - **Save:** Save the archived report(s)
     
     The save settings screen is displayed. [Report Template Name + Report Create Day] is set as the file name. You can change this if necessary.

     Select the file format and the location to save the file, and then click OK.

   - **Delete:** Delete the archived report(s)
     
     The delete confirmation screen is displayed. To delete the file, click OK.
## Maintenance

### Printing a Status Sheet

When the devices in your network are printers, you can check detailed information on the devices by printing a status sheet.

You can send printing commands to multiple selected devices.

1. Select **Device** on the side bar task menu.
2. Select a device (printer) to print a status sheet from the device list.

   **Note:**
   To make multiple selections, press **Ctrl** or **Shift** and click your mouse.

3. Click **Print Status Sheet(s)** on the **Home** tab on the ribbon menu.

4. Click **OK**.

   A status sheet is printed from the printer you selected.

### Backing up and Restoring

You can backup and restore system settings. This allows you to prepare for a system failure, as well as add devices or replace devices.

#### Items that can be backed up and restored

The following items can be backed up and restored.

- **System settings**

  You can save and restore system settings and all Epson Device Admin data to a backup file.

  [“System settings” on page 96](#)
Maintenance

- Device list
  You can save and restore the device list to which devices were added to a backup file.
  
  "Device list" on page 98

- Password list
  You can save and restore the password list managed by Epson Device Admin to a backup file.
  
  "Password settings" on page 100

- Address book
  You can save and restore address book information such as addresses and fax numbers to a backup file.
  
  "Address books" on page 103

- Configuration template
  You can save and restore configuration templates to a backup file.
  
  "Configuration templates" on page 107

- Device settings
  You can save and restore configuration values for devices to a backup file.
  
  "Backing up device settings" on page 129

System settings

You can save the database file containing Option menu settings such as Notification email settings, Discovery conditions, and External site access settings, as well as Alert and Formats settings in .zip file format.

Backing up system settings

1. Select Devices on the side bar task menu.
2. Click Options on the Home tab on the ribbon menu.
3. Click Backup/Restore.
Maintenance

4 Click **Backup**.

![Backup and Restore interface]

5 Specify the destination to save the backup file, and then click **OK**.

6 Click **OK**.

The backup file is saved to the specified destination.

**Restoring system settings**

1 Select **Devices** on the side bar task menu.

2 Click **Options** on the **Home** tab on the ribbon menu.

3 Click **Backup/Restore**.

4 Click **Restore**.

![Restoration interface]
Select the saved backup file, and then click OK.

Click OK.

Restoring is started.

Device list

You can save and read the information on the device list for the device management screen in a device information file.

The following are the device information files.

- Device list file (PLF format)
  This is an XML file containing the method for specifying IP addresses and MAC addresses for the device list.

- Device list file (TXT format)
  This is a TXT file containing IP addresses separated by line breaks.

- Device data file (PRDF format)
  This is an XML file containing device list file information added when collecting device information. This is encrypted for security.

Saving a device information file

Select Devices on the side bar task menu.

Click the Home tab on the ribbon menu.

Click Device List group - Save.
Select the file format and save destination.

Click Save.

Reading a device information file

Select Devices on the side bar task menu. Click the Home tab on the ribbon menu. Click Device List group - Open.

Select the information handling method for the file you want to read.

Select the device information file, and then click Open.

When reading the device list file (PLF format/TXT format), only information for MAC addresses and IP addresses is displayed. To display other information, update the device information.
Maintenance

When reading the device data file (PRDF format), the read-only Logs group is added to the first layer of the tree view. Information on the device is displayed here. When you read the device data file again, the Logs group is replaced with new information.

Password settings

You can backup and restore an administrator’s password for devices using the password management list.

See the following for details on adding and editing passwords.

"Adding and editing a password” on page 59

Backing up passwords

1. Select Devices on the side bar task menu.
2. Click Options on the ribbon menu.
3. Select Password manager.
4. Click Password manager.
The password management screen is displayed.

5. Click **Export**.

The password backup screen is displayed.

6. Click **Browse** to select the destination to save the backup file.

7. Enter a password in **Password**, and then enter the same password in **Confirm new password**.

   Enter the password you want to set using up to 20 ASCII characters.

8. Click **OK**.
Restoring passwords

1. Select Devices on the side bar task menu.
2. Click Options on the ribbon menu.
3. Select Password manager.
4. Click Password manager.
   The password management screen is displayed.

5. Click Import.
   The password restore screen is displayed.

6. Click Browse to select the backup file.
When overwriting current device passwords, select **Overwrite an existing password**.

1. Enter the password you set for the backup file in **Password**.
   - Enter the password you want to set using up to 20 ASCII characters.
2. Click **OK**.

---

**Address books**

You can export and import address books to a file by setting a password.

**Note:**
- This function is only available for supported models.

**Exporting by setting a password**

See the following for details on exporting items except for security information such as passwords and private information.

- “Registering Different Address Books” on page 60

1. Select **Device** on the side bar task menu.
2. Select the device from which you want to export the address book from the device list.

**Note:**
- To make multiple selections, press **Ctrl** or **Shift** and click your mouse.

3. Click [Change Setting] on the [Home] tab on the ribbon menu.
4. Click the item for which you want to edit contact details from the following. Displayed items differ depending on the device being used.

- **Common - Contacts**
- **Administrator Settings - Access Limitation**
- **Scan - Mail Settings**
- **Scan - Target Folder**
- **Fax - Reception - E-Mail**
Maintenance

- Fax - Fax Number

See the following for detailed information on each item.

Epson Device Admin Help 'Device Properties'

5. Click Export.

Screen for Contacts.

6. Select Export with Security Information, and then click OK to set a password.

![Export with Security Information](image)

7. Enter a file name, and then click Save.

An encrypted ENE format binary file is saved. You cannot edit this file.
When importing this file, a password is required.

Importing files containing security information

See the following for details on exporting items except for security information such as passwords and private information.

☞ “Reading the settings file” on page 65

1. Select Devices on the side bar task menu.
2. Select the device for which you want to import an address book from the device list.

   Note:  
   To make multiple selections, press Ctrl or Shift and click your mouse.

3. Click Device Configuration on the Home tab on the ribbon menu.
4. Click the item you want to edit from E-Mail, FAX to Folder, or Fax Number. Displayed items differ depending on the device being used.
5. Click Import.
Screen for Fax Number.

When the "Start Import Wizard Confirmation" message is displayed, click OK.

Set the path to the file you want to import, and then click Next.

Click Browse, and then select the binary file (*.ene) containing information such as email addresses or user information for the Access Limitation function, and then click Open. You need to enter the password set when the file was exported to open a binary file.
8 Click Transmit.

9 When a confirmation screen is displayed, click OK to start transmitting the settings.

10 Click OK to complete transmission.

**Configuration templates**

You can save and restore configuration templates to a file.

**Saving configuration templates**

1 Select Configuration on the side bar task menu.

2 Select a configuration template to backup from the template list.

You cannot select preset configuration templates.

**Note:**
To make multiple selections, press Ctrl or Shift and click your mouse.
**Maintenance**

3. Click **Backup** on the ribbon menu.

4. Select the destination to save the file and enter a file name.

5. Click **Save**.

   TSE format template files are saved together in a Zip file. The configuration template name is not saved.

**Reading configuration templates**

Unzip the Zip file containing configuration templates and retrieve the configuration template files (TSE format).

1. Select **Configuration** on the side bar task menu.

2. Click **Import** on the ribbon menu.

   The file import screen is displayed.

3. Select the configuration template file (TSE format) to be imported.

4. Click **Open**.

   The configuration template is imported and the results are displayed.

5. Click **OK**.
Troubleshooting

Troubleshooting

Troubleshooting for Epson Device Admin.

Cannot discover devices.

This software cannot automatically discover devices from other companies. To add these devices, assign an IP address to the devices, and then specify the IP address manually.

Cannot change the network interface, or cannot use it on the network.

Solution 1)
Check if you can print a network status sheet.
If you can print the sheet, check the network settings printed on the network status sheet.

Solution 2)
Check if hubs and LAN cables are working correctly. For hubs, check if the link lights for the ports where the devices are connected are flashing or lit.

Check the following if the link light is off.

- Connect the hub to a different port.
- Connect to a different hub.
- Replace the LAN cable.

If you still cannot communicate after trying all of the above, the network interface may not be working. See the device manual for details.

Solution 3)
Check if the IP address is valid.
The default IP address is "192.168.192.168". However, you cannot use this address on the network. Change the address according to your environment.

Solution 4)
Check if Keep blocking, Cancel, or Block is selected on the "Windows Security Alert" screen or in your commercially available security software.
Communication cannot be performed if one of these is selected. To enable communication, register this application as an exception in the Windows firewall or your commercially available security software.
Some commercially available security software still may not allow communication. In this situation, close the security software while using this application. When you have finished using this application, restart your security software.
You do not know the IP address.

Solution 1)
If you want to use the DHCP function on the router (DHCP Server, or Wi-Fi router), set the device to automatically acquire the IP address.

Solution 2)
To set up the IP address and subnet mask manually, see the following.

1. Check the IP address of the router (DHCP Server, or Wi-Fi router) that is connected to your computer. See the router’s manual for details on checking the IP address.

2. For IPv4, the IP address is composed of four segments of numbers. From the first to the third segment of the numbers, set the same number as the router. Set a unique number between 1 to 254 for the fourth segment.

Example:
If the router’s IP address is 192.168.1.1
Set the device to 192.168.1.3
Set 255.255.255.0 as the subnet mask if you are on a small network. Set the same number for all devices in the network. If the gateway can be configured, use the same IP address as the router. Note that you cannot use the address 192.168.192.168 on the network.

The message "The network connection is invalid or not set. Check the network settings." is displayed when running Epson Device Admin.

This message is displayed in the following situations.

- When TCP/IP is not built-in to the computer.
- When the computer’s IP address is incorrect.
- When there is no DHCP server and the Epson Device Admin is set to acquire an address from the DHCP server.

Check the computer status, built-in TCP/IP, and set the IP address.

Not Ready is displayed as the IP address on the device list.

Solution 1)
You can set up a network interface even if IP address is not displayed. In this case, MAC address is used to specify the device. You can check the MAC address by printing a status sheet or from the printer's control panel. See the product's documentation for details.

The IP address is displayed correctly when a network interface is configured.

Solution 2)
Go to Devices - Options. Set the discovery conditions, and then click Discovery.  
☞ “Discovery condition settings” on page 30
Troubleshooting

Solution 3)
Go to Options - Startup. Set the Discovering and rebooting timeout (10-180) to a larger value. However, discovering may take some time when a large value is set.
☞ "Operation Settings" on page 21

IP address changes on its own.

Solution 1)
Set the Method for Specifying IP Address to Manual on the Basic - TCP/IP screen, and then manually enter the IP address.

Solution 2)
If you want to set the Method for Specifying IP Address to Automatic and your DHCP server does not support dynamic DNS, make sure you turn on the devices in the same order every time or keep them turned on.
Appendix

Secondary Device Management Method

SYLK is a secondary method for managing devices and their settings.

Assigning IP address

Epson Device Admin can recognize the Epson devices on the network even when IP addresses have not been assigned. Follow the steps below to assign an IP address.

1. Connect devices to the network using an Ethernet cable.
2. Discover the devices.
   - Set the necessary discovery range.
     - See "Discovering devices" on page 30
3. Use the filter feature on the device list to unfilter devices by [IP address].
   - See "Using filters" on page 73
4. Save a SYLK file for making settings.
   - See "Create a file outlining the settings" on page 118
5. Enter IP addresses in the network settings columns in the SYLK file, and then save the file.
6. Set IP addresses for the devices using the batch settings feature.
   - See "Batch Settings" on page 113

Checking for overlapping items

When managing multiple devices, conflicts may occur when replacing devices for settings that are assigned unique values for each device, such as IP addresses.

You can check for overlapping items when reading a SYLK file for device settings. Follow the steps below to find overlapping IP addresses.

1. Select devices in each group, or select all devices, to confirm conflict items from the device list.
2. Save a SYLK file for making settings.
   - See "Create a file outlining the settings" on page 118
3. Apply all SYLK files.
Assigning information automatically

When there are items that conflict, the following screen is displayed.
Check the message displayed.

Search for items that conflict in the SYLK file created in step 2, and then correct the conflicts.

Apply the SYLK file again.

Batch Settings

Make batch settings for multiple devices by importing a SYLK (*.slk) file.

See the following for details on creating a SYLK file.

Assigning information automatically

1. Select Devices on the side bar task menu.
2. Select the device you want to configure from the device list.
Click **Batch Settings** on the **Home** tab on the ribbon menu.

**Note:**
When you select **Use batch configuration** in **Options** - **Customize Ribbon**, the **Batch Settings** button is displayed on the Device screen ribbon menu.

☞ “**Operation Settings**” on page 21
Appendix

4 Click **Open**.

![Batch Settings Window]

5 Select the SYLK file (*.slk) containing the settings, and then click **Open**.

The settings in the SYLK file are applied to the device.

![Open File Window]

6 Select the devices for which you want to perform batch settings with the **Status** column set to **Unset**, and the **Process Status** set to **Assign Successful**.
See the following for detailed information on the Batch Settings screen.

Epson Device Admin Help "Batch Settings Screen"

Click Transmit.

When the password entry screen is displayed, enter the password, and then click OK.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.
Appendix

Transmit the settings.

![Password dialog box]

**Note:**
- A progress meter is displayed while the information is transmitted to the network interface. Do not turn off the device or the wireless adapter, and do not send any data to the device.
- See the following to set a password.
  "Setting an Administrator Password" on page 54

9 Click **OK**.

![Transmitting dialog box]

10 Check the status of the device you set.

For devices that show ✗ or ⌀, check the contents of the settings file, and that the device has rebooted normally.

See the following for detailed information on the Batch Settings screen.
Assigning information from settings one at a time (Manually assigned)

Create a file describing the IP address, subnet mask, and the default gateway, and select one device at a time to make settings.

Create a file outlining the settings

1. Open a spreadsheet application (such as Microsoft Excel).
2. Enter "TCPIP_IPAddressAuto", "TCPIP_IPAddress", "TCPIP_SubnetMask", and "TCPIP_Gateway" in the first row as the setting item names.

Enter setting items for the following text strings. To distinguish between upper case/lower case and double-byte/single-byte characters, if only one character is different, the item will not be recognized.

Enter the setting item name as described below; otherwise, Epson Device Admin cannot recognize the setting items.

<table>
<thead>
<tr>
<th>TCPIP_IPAddressAuto</th>
<th>TCPIP_IPAddress</th>
<th>TCPIP_SubnetMask</th>
<th>TCPIP_Gateway</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note:
Create a file without MAC address information. Because the MAC address is automatically set as the key for use by default, information is assigned automatically when a MAC address is found, and manual assignment cannot be performed. You can change the automatically assigned keys for use in [Tools] - [Options] - [Auto Assign] - [Auto Assign Key Settings] on the [Batch Settings] screen.
Enter the values in each row.

"TCPIP_IPAddressAuto" specifies the setting method for assigning the IP address. If the setting value is "5", the static IP address is manually assigned.

<table>
<thead>
<tr>
<th>TCPIP_IPAddressAuto</th>
<th>TCPIP_IPAddress</th>
<th>TCPIP_SubnetMask</th>
<th>TCPIP_Gateway</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>192.168.100.102</td>
<td>255.255.255.0</td>
<td>192.168.100.101</td>
</tr>
<tr>
<td>5</td>
<td>192.168.100.103</td>
<td>255.255.255.0</td>
<td>192.168.100.101</td>
</tr>
<tr>
<td>5</td>
<td>192.168.100.104</td>
<td>255.255.255.0</td>
<td>192.168.100.101</td>
</tr>
</tbody>
</table>

Enter a name and save as a SYLK file (*.slk).

Reading the configuration file and making settings one at a time

1. Select [Device] on the side bar task menu.
2. Select the device you want to configure from the device list.

*Note: To make multiple selections, press Ctrl or Shift and click your mouse.*

Click **Batch Settings** on the **Home** tab on the ribbon menu.
Click Open.

Note:
When you select Use batch configuration in Options - Customize Ribbon, the Batch Settings button is displayed on the Device screen ribbon menu.

“Operation Settings” on page 21
Select the SYLK file (*.slk) containing the settings, and then click Open.

Click Display Devices, and then select the device you want to set.

**Note:**
To make multiple selections, press Ctrl or Shift and click your mouse.
Appendix

7 Click **Tools - Manual Assign**.

![Manual Assign Menu](image)

**Note:**
If you discover a device when the file is open or after opening the file, auto assignment is performed. If the target setting information has already been assigned to other devices, setting information is not displayed on the **Manually assign setting information** screen. Release the assignments from **Tools - Release Assign**.

8 Select the setting information line you want to assign, and then click **OK**.

![Manual Assign Confirmation](image)
Check that **Unset** is displayed in the **Status** column and **Assign Successful** is displayed in the **Process Status** column.

Click **Transmit**, and then click **OK**.

---

**Creating a SYLK file to describe the settings**

You can create a SYLK file to describe information for performing batch settings. You can create a SYLK file using one of the following methods.

**Creating a SYLK file by acquiring information from the connected device**

1. Select **Device** on the side bar task menu.
2. Select the device you want to configure from the device list.
Click **Batch Settings** on the **Home** tab on the ribbon menu.

**Note:**
When you select **Use batch configuration** in **Options - Customize Ribbon**, the **Batch Settings** button is displayed on the Device screen ribbon menu.

☞ “Operation Settings” on page 21
Appendix

4 Click **File - Save as**.

![Screenshot of File menu with Save As option highlighted]

5 Enter the file name and select the target folder, and then click **Save**.

A backup file (*.slk) containing the current settings for all devices is created.

![Screenshot of Save As dialog box]

6 Open the saved SYLK file in a spreadsheet application (such as Microsoft Excel) or in a text editor.
Appendix

Setting information is entered in each row. Each row contains the settings for each individual device. Explanations for the setting items is provided on the following page.

"Setting items for the SYLK file" on page 131

You can change settings or add a new row and enter setting information for a new device, and then save the file.

Creating a SYLK file based on a template

This section explains how to create a SYLK file based on a TCP/IP template.

Select Device on the side bar task menu.

Select the device you want to configure from the device list.

Note:
To make multiple selections, press Ctrl or Shift and click your mouse.

Click Batch Settings on the Home tab on the ribbon menu.
Appendix

Note:
When you select **Use batch configuration** in **Options - Customize Ribbon**, the **Batch Settings** button is displayed on the Device screen ribbon menu.

☞ “Operation Settings” on page 21

---

4. Click **File - Save Template File - TCP/IP settings**.

5. Enter the file name and select the target folder, and then click **Save**.
A SYLK file (*.slk) containing the TCP/IP related items written is created.

Open the saved SYLK file in a spreadsheet application (such as Microsoft Excel) or in a text editor. Enter the MAC address and values such as IP address, subnet mask, and default gateway for each row.

See the following for details on each setting item.

“For Setting items for the SYLK file” on page 131

Save the file.

Creating a new SYLK file

Using the MAC address and model name as the keys, you can create a new SYLK file to set the IP address.

Open a spreadsheet application (such as Microsoft Excel).

Enter "Info_MACAddress", "Info_ModelName", and "TCP/IP IPAddress" in the first row as the setting item names.

Enter setting items for the following text strings. To distinguish between upper case/lower case and double-byte/single-byte characters, if only one character is different, the item will not be recognized. Enter the setting item name as described below; otherwise, Epson Device Admin cannot recognize the setting items.
Appendix

Enter the MAC address, model name, and IP address for each network interface.

<table>
<thead>
<tr>
<th>Info_MACAddress</th>
<th>Info_ModelName</th>
<th>TCPIP_IPAddress</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000XXXX0001</td>
<td>ALC-XXXX</td>
<td>192.168.100.102</td>
</tr>
<tr>
<td>0000XXXX0002</td>
<td>ALC-XXXX</td>
<td>192.168.100.103</td>
</tr>
<tr>
<td>0000XXXX0003</td>
<td>ALC-XXXX</td>
<td>192.168.100.104</td>
</tr>
</tbody>
</table>

Enter a name and save as a SYLK file (*.slk).

Back up device settings

You can backup device settings by using the batch setting function.

Output a device setting value as a SYLK file.

**Note:**
When you select Use batch configuration in Options - Customize Ribbon, the Batch Settings button is displayed on the Device screen ribbon menu.

“Operation Settings” on page 21

Select Devices on the side bar task menu.

Select the device you want to backup from the device list.

**Note:**
To make multiple selections, press Ctrl or Shift and click your mouse.
Appendix

Click **Batch Setting** on the **Home** tab on the ribbon menu.

![Image of Epson Device Admin interface]

**Note:**
Select the devices for which you do not want to create a backup file, and then click **Tools - Release Assign**. Click **Yes** when the confirmation message is displayed, and the **Status** column changes to **Unassigned**.

Click **File - Save as**.

![Image of Save as dialog box]

Enter the file name and select the target folder, and then click **Save**.
Appendix

A backup file (*.slk) containing the selected device settings is created.

Setting items for the SYLK file

This section explains the main settings that can be set in the SYLK file.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info_SerialNumber</td>
<td>Displays the serial number of a device. This value is acquired from the device. The device is not affected by changing the value.</td>
</tr>
<tr>
<td>Info_MACAddress</td>
<td>Displays the MAC address of a device. This value is acquired from the device. The device is not affected by changing the value.</td>
</tr>
<tr>
<td>Info_ModelName</td>
<td>Displays the model name of a device. This value is acquired from the device. The device is not affected by changing the value.</td>
</tr>
<tr>
<td>Info_Software.X.Category (X:1 to 50)</td>
<td>Displays information on the device’s software. This value is acquired from the device. The device is not affected by changing the value.</td>
</tr>
<tr>
<td>Info_Software.X.Name (X:1 to 50)</td>
<td>Displays information on the device’s software. This value is acquired from the device. The device is not affected by changing the value.</td>
</tr>
<tr>
<td>Info_Software.X.Version (X:1 to 50)</td>
<td>Displays information on the device’s software. This value is acquired from the device. The device is not affected by changing the value.</td>
</tr>
<tr>
<td>Info_Software.X.Vendor (X:1 to 50)</td>
<td>Displays information on the device’s software. This value is acquired from the device. The device is not affected by changing the value.</td>
</tr>
</tbody>
</table>
### Appendix

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Info_CommonDevice</strong></td>
<td>Enter a device name to use as a common protocol. Enter between 2 and 15 characters using A-Z, a-z, 0-9, and hyphens (-). You can only use letters for the first character. You cannot use a hyphen for the final character. You cannot use the following operations and values.</td>
</tr>
<tr>
<td></td>
<td>- Automatically acquiring DNS host name</td>
</tr>
<tr>
<td></td>
<td>- Exceeding 251 characters for the host name or the domain name.</td>
</tr>
<tr>
<td><strong>Info_CommonLocation</strong></td>
<td>Enter information to identify the device. For example, where the device is located. The number of characters you can enter varies depending on the product.</td>
</tr>
<tr>
<td><strong>TCPIP_IPAddressAuto</strong></td>
<td>Specify whether the IP address is set manually or automatically.</td>
</tr>
<tr>
<td></td>
<td>1: Auto</td>
</tr>
<tr>
<td></td>
<td>5: Manual</td>
</tr>
<tr>
<td><strong>TCPIP_IPType_BOOTP</strong></td>
<td>Specify whether you want to set the IP address automatically with BOOTP.</td>
</tr>
<tr>
<td></td>
<td>When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: OFF.</td>
</tr>
<tr>
<td></td>
<td>1: ON</td>
</tr>
<tr>
<td></td>
<td>0: OFF</td>
</tr>
<tr>
<td><strong>TCPIP_IPType_RARP</strong></td>
<td>Specify whether you want to set the IP address automatically with RARP.</td>
</tr>
<tr>
<td></td>
<td>When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: OFF.</td>
</tr>
<tr>
<td></td>
<td>1: ON</td>
</tr>
<tr>
<td></td>
<td>0: OFF</td>
</tr>
<tr>
<td><strong>TCPIP_IPType_APIPA</strong></td>
<td>Specify whether you want to set the IP address automatically with APIPA.</td>
</tr>
<tr>
<td></td>
<td>When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: OFF.</td>
</tr>
<tr>
<td></td>
<td>1: ON</td>
</tr>
<tr>
<td></td>
<td>0: OFF</td>
</tr>
<tr>
<td><strong>TCPIP_IPType_PING</strong></td>
<td>Specify whether you want to set the IP address automatically with PING.</td>
</tr>
<tr>
<td></td>
<td>When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: OFF.</td>
</tr>
<tr>
<td></td>
<td>1: ON</td>
</tr>
<tr>
<td></td>
<td>0: OFF</td>
</tr>
<tr>
<td><strong>TCPIP_IPAddress</strong></td>
<td>Specify the IP address in IPv4 format.</td>
</tr>
<tr>
<td></td>
<td>You cannot use the following addresses.</td>
</tr>
<tr>
<td></td>
<td>0.0.0.0</td>
</tr>
<tr>
<td></td>
<td>255.255.255.255</td>
</tr>
<tr>
<td></td>
<td>127.0.0.1</td>
</tr>
<tr>
<td></td>
<td>224.0.0.0 to 239.255.255</td>
</tr>
<tr>
<td><strong>TCPIP_SubnetMask</strong></td>
<td>Specify the subnet mask in IPv4 format.</td>
</tr>
<tr>
<td></td>
<td>You cannot use the following addresses.</td>
</tr>
<tr>
<td></td>
<td>0.0.0.0</td>
</tr>
<tr>
<td></td>
<td>255.255.255.255</td>
</tr>
<tr>
<td><strong>TCPIP_Gateway</strong></td>
<td>Specify the default gateway in IPv4 format.</td>
</tr>
<tr>
<td></td>
<td>You cannot use the following addresses.</td>
</tr>
<tr>
<td></td>
<td>255.255.255.255</td>
</tr>
<tr>
<td></td>
<td>224.0.0.0 to 239.255.255</td>
</tr>
<tr>
<td><strong>TCPIP_DNS_AddressAuto</strong></td>
<td>Specify whether you want to obtain the DNS server address manually or automatically.</td>
</tr>
<tr>
<td></td>
<td>When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: Manual.</td>
</tr>
<tr>
<td></td>
<td>0: Manual</td>
</tr>
<tr>
<td></td>
<td>1: Auto</td>
</tr>
</tbody>
</table>
### Appendix

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCPIP_DNS_Server.1 to</td>
<td>Specify 1 to N as the number of DNS server addresses that can be registered to the device in IPv4 format. You cannot use the following addresses. 255.255.255.255 0.0.0.0</td>
</tr>
<tr>
<td>TCPIP_DNS_Server.N</td>
<td></td>
</tr>
<tr>
<td>TCPIP_DNS_HostDomainAuto</td>
<td>Specify whether you want to obtain the DNS host name and domain name manually or automatically. When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: Manual. 0: Manual 1: Auto</td>
</tr>
<tr>
<td>TCPIP_DNS_HostAuto</td>
<td>Specify whether you want to obtain the DNS host name and domain name manually or automatically. When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: Manual. 0: Manual 1: Auto</td>
</tr>
<tr>
<td>TCPIP_DNS_DomainAuto</td>
<td>Specify whether you want to obtain the DNS host name manually or automatically. When TCPIP_IPAddressAuto is set to 5: Manual, this value is fixed at 0: Manual. 0: Manual 1: Auto</td>
</tr>
<tr>
<td>TCPIP_DNS_HostName</td>
<td>Enter a DNS host name. Enter between 2 and 63 characters using A-Z, a-z, 0-9, hyphens (-), and dots (.). You can only use letters for the first character. You cannot use a hyphen or a dot for the final character. This value is invalid if the total number of characters of the host name and the domain name exceeds 251.</td>
</tr>
<tr>
<td>TCPIP_DNS_DomainName</td>
<td>Enter a DNS name. Enter between 2 and 249 characters using A-Z, a-z, 0-9, hyphens (-), and dots (.). You can only use letters for the first character. You cannot use a hyphen or a dot for the final character. You cannot use the following values. Using more than one dot in a row (for example ..) Exceeding 251 characters for the host name or the domain name.</td>
</tr>
<tr>
<td>TCPIP_DNS_DNSRegist</td>
<td>Specify whether you want to register the network interface address for the DNS server. 0: Do not register 1: Register</td>
</tr>
<tr>
<td>TCPIP_DNS_DirectRegist</td>
<td>Specify how to register the network interface address to the DNS server. 0: Relay the DHCP 1: Register directly</td>
</tr>
<tr>
<td>TCPIP_EnableBonjour</td>
<td>Specify whether to use Bonjour. 0: Disable 1: Enable</td>
</tr>
<tr>
<td>TCPIP_BonjourName</td>
<td>Specify the Bonjour name. Enter between 2 and 53 characters using A-Z, a-z, 0-9, and hyphens (-). You can only use letters for the first character. You cannot use a hyphen for the final character.</td>
</tr>
<tr>
<td>TCPIP_BonjourPrinterName</td>
<td>Specify the Bonjour service or Bonjour printer name. Enter between 1 and 41 characters using A-Z a-z 0-9 !&quot;#$%&amp;'()*+,-./:;&lt;=&gt;?@^_`{</td>
</tr>
</tbody>
</table>
### Appendix

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableMSNet</td>
<td>Specify whether to use Microsoft network shared printing.</td>
</tr>
<tr>
<td>0: Disable</td>
<td></td>
</tr>
<tr>
<td>1: Enable</td>
<td></td>
</tr>
<tr>
<td>MSNet_HostName</td>
<td>Specify the host name of an MS Network.</td>
</tr>
<tr>
<td></td>
<td>Enter between 1 and 15 characters using A-Z a-z 0-9 !#$@%&amp;;'()-.^_{}~ and space.</td>
</tr>
<tr>
<td>MSNet_WorkGroupName</td>
<td>Specify the Workgroup name of an MS Network or domain name.</td>
</tr>
<tr>
<td></td>
<td>Enter between 1 and 15 characters using A-Z a-z 0-9 !#$@%&amp;;'()-.^_{}~ and space.</td>
</tr>
<tr>
<td>EnableAppleTalk</td>
<td>Specify whether to use AppleTalk.</td>
</tr>
<tr>
<td>0: Disable</td>
<td></td>
</tr>
<tr>
<td>1: Enable</td>
<td></td>
</tr>
<tr>
<td>NetIF_EnableTimeServer</td>
<td>Specify whether to use the time server.</td>
</tr>
<tr>
<td>0: Do not use</td>
<td></td>
</tr>
<tr>
<td>1: Use</td>
<td></td>
</tr>
<tr>
<td>NetIF_TimeServer</td>
<td>Specify the address of the time server.</td>
</tr>
<tr>
<td></td>
<td>The format you can enter varies depending on the server.</td>
</tr>
<tr>
<td>NetIF_TimeServerInterval</td>
<td>Specify the interval for updating the time server information in seconds.</td>
</tr>
<tr>
<td></td>
<td>Enter a value between 1 and 1440 in integral numbers.</td>
</tr>
<tr>
<td>NetIF_TimeServerStatus</td>
<td>Displays the communication status of the time server.</td>
</tr>
<tr>
<td></td>
<td>This value is acquired from the device. The device is not affected by changing the value.</td>
</tr>
<tr>
<td>USB_HOSTIF</td>
<td>Specify whether to use the USB host I/F.</td>
</tr>
<tr>
<td>3: On</td>
<td></td>
</tr>
<tr>
<td>4: Off</td>
<td></td>
</tr>
<tr>
<td>USB_IF</td>
<td>Specify whether to use the USB I/F.</td>
</tr>
<tr>
<td>3: On</td>
<td></td>
</tr>
<tr>
<td>4: Off</td>
<td></td>
</tr>
<tr>
<td>Admin_UserName</td>
<td>Specify the administrator name for the device.</td>
</tr>
<tr>
<td></td>
<td>Enter an administrator name between 1 and 255 characters except for ASCII control code.</td>
</tr>
<tr>
<td>Admin_PanelLock</td>
<td>Specify whether to enable panel operations.</td>
</tr>
<tr>
<td>3: Enable</td>
<td></td>
</tr>
<tr>
<td>4: Disable</td>
<td></td>
</tr>
<tr>
<td>AdminCurrentPassword</td>
<td>Enter the current password when you want to change the administrator password using automatic authentication.</td>
</tr>
<tr>
<td>AdminNewPassword</td>
<td>Specify an administrator password of the device.</td>
</tr>
<tr>
<td></td>
<td>Enter between 1 and 20 characters using A-Z a-z 0-9 !#$@%&amp;;'()-.^_{}~ and space. When an administrator password is set for device, you need to enter the current password.</td>
</tr>
<tr>
<td>NICResetCmd</td>
<td>Reset device settings to their defaults.</td>
</tr>
<tr>
<td></td>
<td>True: Reset device settings to factory defaults</td>
</tr>
</tbody>
</table>

**Note:**
Available items vary depending on the device. #NULL# is entered for setting items that are not supported.
Copyright and Trademarks

- EPSON is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a trademark of Seiko Epson Corporation.

- Microsoft, Windows, and Windows Vista are registered trademarks of Microsoft Corporation.

- General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

© Seiko Epson Corporation 2016. All rights reserved.

Notices

- Reproduction of information in this manual is prohibited.

- All information in this manual is subject to change without notice.

- If you find inaccuracies or have concerns about this manual, contact Epson.

- Notwithstanding the preceding article, Epson cannot be held responsible for any effects resulting from the use of the product.

- Epson cannot be held responsible for any failures caused by the improper use of the product and the improper repair of the product by a third party.
Appendix